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Digital Editing and Splicing 

Audio data can be destructively cut, copied, and pasted in Sound 
Designer II much like text can be manipulated in a word processor. If 
you are accustomed to using the Macintosh you will find many of 
these editing functions familiar. 

NOTE: Most cut and paste edits can be performed faster in the Playlist. 
Large destructive edits entail a significant amount of time for hard disk 
access and screen updates. 

Editing Out a Passage 
A selected area can be cut out of the soundfile and the remaining 
pieces joined together in the digital equivalent of a tape splice. 

To permanently remove a portion of the soundfile: 

• Select the region of the waveform to be removed using the 
Selection tool. 

• Select Clear from the Edit menu. 

Moving a Passage 
A selected area can also be moved to another place in the soundfile, 
automatically making room for the passage and dosing the gap left by 
the old. 
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To remove a portion of the soundfile and place it elsewhere: 

• Select the region of the waveform to be moved using the 
Selection tool. 

• Select Cut from the Edit menu. This places the selected wave 
data on the Oipboard. 

• Position the cursor at the location you wish to place the wave 
data and click. 

• Select Paste from the Edit menu. The Clipboard wave data will 
be placed at the selected location and all soundfile data to the 
right will be shifted to accommodate the pasted data. These 
last two operations can be repeated as many times as needed. 

NOfE: Editing data with radically different amplitudes can result in 
clicks or pops at the edit points. These unwanted artifacts can usually 
be eliminated by performing edits with Smoothing engaged in the Edit 
menu. Smoothing performs fast crossfades at the edit points to elimi­
nate abrupt changes in amplitude. Smoothing is a simple toggle: a 
check next to the menu item indicates that smoothing is engaged. 

Duplicating a Passage 
A selected passage can be duplicated as many times as necessary. 

To copy a portion of the soundfile and place it elsewhere: 

• Select the region of the waveform to be copied. 

• Select Copy from the Edit menu. This places the selected wave 
data on the Oipboard. 

• Position the cursor at the location you wish to place the wave 
data and click. 
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• Select Paste from the Edit menu. The Clipboard wave data will 
be placed at the selected location and all soundfile data to the 
right will be shifted to accommodate the pasted data. These 
last two operations can be repeated as many times as needed. 

NOTE: Unlike duplication with the Playlist, pasting in this manner will 
add length to the soundfile. Pasting will only be permitted if there is 
enough disk space to accommodate the additional data. 

NOTE: If the data on the Clipboard is from a single channel and you 
select a destination that includes both channels, a dialog will appear 
allowing you to select the destination channel. 

To paste a region without altering the soundfile's length: 

• Cut or copy source data to the Oipboard as previously de­
scribed. 

• Position the cursor at the location you wish to place the wave 
data and click. 

• Select Replace from the Edit menu. The Clipboard data will 
replace as much existing data as is required to accommodate 
the pasted data. 

NOTE: If a destination range is selected instead of a simple insertion 
point, the Replace command will only fill that range with as much data 
as will fit from the Clipboard. 
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Trimming Excess Data 

Audio before and after a selected waveform range can be removed 
from a file with the Trim command. This command provides a handy 
means of quickly removing all data but the selected range. 

To trim excess data from a soundfile: 

• Select the area of the soundfile you wish to retain. 

• Select Trim from the Edit menu. All data but the selected area 
will be removed from the soundfile. 

Reversing a Passage 

Reversed sounds are a popular effect in sound design. Sound Designer 
II lets you perform this type of edit on a selection very easily. 

To reverse a passage: 

• Select the desired passage. 

• Select Reverse from the Edit menu. The selected data is written 
back to the disk in reverse order. 

Permanently Silencing A Passage 
It is sometimes desirable to permanently mute passages where un­
wanted ambient noise occurs or where it is desirable to maintain time 
continuity without actual audio output. The Silence command is 
particularly useful in these cases. 
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To replace a selected range in a soundfile with silence: 

• Select the passage to be silenced. 

• Select Silence from the Edit menu. All amplitudes will be set to 
zero while preserving the length of the soundfile. 

Fading a Passage In and Out 

While the Playlist provides a method of fading passages or entire 
Playlists in and out non-destructively, you can also permanently create 
a fade in/ out in the soundfile itself. 

To fade a passage of a soundfile in or out: 

• Select the passage you wish to fade. 

• Select Fade In from the Edit menu for a linear fade from zero 
amplitude to full amplitude over the selected range; select Fade 
Out from the Edit menu for a linear fade from full amplitude 
to zero amplitude over the selected range. 

All of the previously mentioned operations will permanently alter your 
soundfile data. Use the Playlist if you wish to make non-destructive 
changes. 

Sound Designer II 



Optimizing Playback Levels 

In cases where a soundfile has been recorded with too little amplitude, 
or where volume is inconsistent through out the range of a soundfile 
(as in a poorly recorded voice-over), the Normalize function will allow 
you to boost all levels in a selected passage uniformly so that the 
loudest peak is set to the maximum amplitude before clipping. 

To optimize your playback levels automatically: 

• Select the passage to be optimized. (If no selection is made, the 
Normalize command will affect the entire file). 

• Select Nonnalize from the Edit menu. 

Levels can also be uniformly altered by a user-defined amount using 
the Change Gain controls. 

To change the playback levels in a passage manually: 

•Select the passage to be altered (or no selection to affect the 
entire file). 

• Select Change Gain from the Edit menu. The Change Gain 
dialog appears. 
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The Change Gain dialog 

• Oick on the Peak Value button to see the percentage value of 
the highest amplitude in the selected range relative to clipping. 

• Select the amount of change desired, either by entering a dB 
value, entering a percentage value, or sliding the Gain control. 

•Click OK. 

• Watch the clipping information as the amplitudes are altered. 
(The display shows both the number of individual samples 
clipped, as well as the number of continuous samples dipped 
over time.) If clipping occurs, select Undo from the Edit menu 
and try the Change Gain command again with a lower value. 

Inverting Amplitudes 
The creation of certain loops and mixes are sometimes facilitated more 
easily by inverting the waveform's amplitude. 
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To invert the amplitude of a waveform: 

•Select the desired passage. 

• Select Invert from the Edit menu. The amplitudes will be 
inverted (positive values become negative and vice versa). 
Performing the operation a second time (or selecting Undo) 
returns the waveform to its original state. 

About Digital Signal Processing 

The concept of digital signal processing (DSP) is one of the central 
ideas behind Sound Designer II. Sound Designer II is a sound work­
shop that can be used to manipulate sound in many ways. A large 
percentage of these "manipulations" fall into the realm of signal 
processing. 

Traditionally, in the analog world, signal processing has been accom­
plished by running a signal through a series of circuits in outboard 
gear. The result of this is an output signal which has been changed in a 
specific way to produce a predictable effect. 

Equalization is a good example of this. In the analog realm, a known 
signal is passed through an equalizer that lets you adjust circuit 
parameters to alter the shape, and hence the spectral content, of that 
signal. Unfortunately, this process generally yields an increase in 
overall noise in proportion to the amount of processing. 

Digital signal processing is based on exactly the same concept, with 
one major exception-DSP functions accomplish their tasks entirely in 
the digital realm. Sound Designer II looks at sounds as a collection of 
data points (samples) indicating the instantaneous amplitudes of a 
sound wave over time. Instead of using a circuit to change the shape of 
a signal, Sound Designer II uses algorithms-mathematical descrip­
tions of the relationship between one signal and another. 
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DSP has its advantages and disadvantages. Unlike most analog 
processing, DSP adds little or no noise to the signal, thereby maintain­
ing the integrity of the sound. However, most digital signal processing 
involves very sophisticated algorithms, which require a long time to 
do their job, and this prevents real-time adjusbnent of parameters. 

Now, with the advent of signal processing chips like the one on a 
Sound Accelerator II card, some of these problems disappear. The 
card's DSP chip takes over most signal processing tasks, and frees up 
your Mac for other tasks. For this reason, you will find that many of 
Sound Designer II' s DSP functions can be both ad justed and used in 
real-time. 

You should, however, be aware that while DSP is a very useful and 
powerful Sound Designer II feature, it can't work miracles. If you try 
to put a Sound Designer II DSP module to use beyond reasonable 
musical limits (time compressing a five minute song down to 2 min­
utes, for example), you may be disappointed. If your soundfile is 
flawed from the start, "fixing it in the mix" may take longer and yield 
poorer results in the end than simply resampling your source material. 

DSP represents a significant step forward in personal digital audio, 
and it is only the beginning of a methodology that will certainly see 
much wider acceptance over the next decade. 

Mixing Up to Four Soundfiles 

Digital mixing and merging are the tools you'll use to mix multiple 
soundfiles into a single soundfile. Using Sound Designer II' s digital 
mixing function, you can take up to four individual mono or stereo 
soundfiles and mix them together with full level, pan, and delay 
control to create a new mono or stereo soundfile. 
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To mix two, three, or four soundfiles to create a new soundfile: 

• Open all of the soundfiles you wish to mix. 

• Choose the Mix command in the DSP menu. The Mix window 
will appear on your screen. 

MIH 

1' 2 I " 21 
!1 !2 40 40 
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l8I Scale 
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I 2.100 I I 0.000 I I 4.2joO I j 3.500 Delay msec 

The Mix window 

• Oick on either Mono or Stereo. This describes the format of the 
soundfile that will be created as a product of the mix. 

• Oick to place an X in the Scale box if you want the input 
soundfiles to be scaled automatically before the mix is done. 
Scaling makes sure that you don't accidentally clip the output 
waveform by insuring that the mix creates no amplitudes that 
are over 100% of the allowable maximum amplitude. 
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• Select an input soundfile for two or more of the fader channels 
by clicking and holding on the Soundfile pop-ups. 

• If you are using stereo input files, make sure that the channel 
number boxes show both left (1) and right (2) channels. 

• Use the mouse to set the fader levels of each channel of the 
input soundfiles-either by dragging the fader or by clicking 
and dragging anywhere inside the fader area. The fader levels 
describe how much of each input sound will be present in the 
mixed output sound. 

• If you are creating a stereo output file, set the stereo pan of 
each input channel by dragging the triangular stereo image 
markers to the right or left. These markers tell you where each 
channel will be placed in the output stereo image. Remember 
to set stereo input files to the correct full right and full left 
channel pan positions, if you want to maintain the stereo 
image. 

• Enter the delay you want (if any) for each soundfile within the 
mix. The delay setting, specified in milliseconds, lets you set 
the size of the time offset before the soundfile appears in the 
output mix. 

• When all settings are to your liking, dick on the Mix button to 
perform the mix. After some computation, a Save dialog will 
appear. 

• Enter a name for the file that will contain the new mix. (The 
new file cannot be set to replace one of the input soundfiles.) 

• Choose a format, then dick on the New button. 

Your mix will be completed after some number crunching. (The longer 
and greater the number of files, the longer the mix will take to calcu­
late.) When the new mix soundfile appears, you can audition it to see if 
it came out as you intended. If not, try the mix again. All Mix window 
settings are retained until you quit Sound Designer II. 
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NOfE: A useful application of the Mix function is creating a mono mix 
of a stereo soundfile. 

Merging Two Soundfiles 

Sound Designer 11' s digital merging functions are advanced 
crossfading tools that allow you to take any two mono or stereo 
soundfiles and create a new soundfile that crossfades from one of the 
original files to the other. 

The merged soundfile fades between marker positions in two files as 
shown in the following diagram: 

"From" Soundfile 

'To" Soundfile 

Merge 
Start 

Merge 
End 

Anatomy of a merge 

The difference between mixing and merging is that mixing can only be 
used to create a new soundfile that is a static mix of all the input 
soundfiles. You can adjust the level (amount) of any soundfile that will 
be mixed, but you can't change or fade any of the input waveforms 
over time. Merging, on the other hand, makes it possible to fade out 
one of the input soundfiles as the other is faded in (commonly called a 
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cro~fade). The amount of time taken to fade between one waveform 
and the other is completely adjustable. 

To merge two soundfiles into a new soundfile: 

• Open the two soundfiles you wish to merge. 

• Place a numbered marker in the soundfile that will begin the 
new merge file. The marker must be placed at the point where 
the crossfade should begin. 

• Place a numbered marker in the soundfile that will end the 
new merge file. The marker must be placed at the point where 
the crossfade between files should end. 

• Choose the Merge command on the DSP menu. The Merge 
window will then appear. 

Merge 

From: Uelcro Shuffle Mork er: Chorus 

To: Micrownue Cats I Morker: test marker I 
Merge length: 

I 141056 I samples, or 13.198551 seconds 

Crossfade Shape: ® Linear O Equal Power 

( Merge ) 

The Merge window 

• Use the From: pop-up menu to choose the soundfile that will 
begin the new merge soundfile. 
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• Use the Marker: pop-up menu next to the "From" soundfile 
name to choose the name of the marker that designates the 
beginning of the crossfade. 

• Use the To: pop-up menu to choose the soundfile that will end 
the new merge soundfile. 

• Use the Marker: pop-up menu next to the ''To" soundfile name 
to choose the name of the marker that designates the end of 
the crossfade. 

• Set the Merge length to dictate how long the crossfade between 
the two markers will be. The merge length will default to the 
longest allowable setting. This will either be the distance 
between the merge "From:" marker and the end of the merge 
"From:" waveform, or the distance between the start of the 
''To:" file and the "To:" marker-whichever is greater. 

• Oick on the box in front of the crossfade shape you desire. 
Linear crossfades use linear fade curves, and generally pro­
duce better results. If you find that the center of your crossfade 
area seems to lose volume, try the equal power crossfade, 
which uses a fade curve that is pushed up by 3 dB at the 
crossfade center. 

• When all merge settings are to your liking, click on the Merge 
button. After calculation, a Save dialog will appear prompting 
you to select the name of a file that will contain the new 
merged waveform. (The new file cannot be set to replace one 
of the input soundfiles.) 

• Choose a file name and format, then click on the New button. 

After an appropriate amount of number crunching, the merged file 
will appear in the Soundfile Window. (Longer files require more 
calculations.) If the merge didn't tum out as planned, try it again. 
Merge window settings are retained until you quit Sound Designer II. 
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NOTE: Take care not to set the merge length to a value greater than the 
time between the "From:" marker and the "To:" marker. This will 
create a gap of silence in the crossfade. 

Sample Rate Conversion 

Sound Designer H's sample rate conversion capability makes it pos­
sible to alter the sample rate of any soundfile without changing that 
sound's pitch. This is a very powerful tool that lets you transmit a 
sound file to another digital device such as a DAT player, CD Re­
corder, etc. 

For example, if you had originally recorded some stereo music on a 
DAT player at 48 kHz but wanted to digitally transfer that file to 
Sound Tools II, edit it, and then master it to a CD Recorder at 44.1 kHz, 
you could easily accomplish this. You would simply transfer the 
music to Sound Tools II at the original 48 kHz, edit it, and then Sample 
Rate Convert the file to the desired 44.1 kHz before mastering it to the 
CD Recorder. 

The sample rate conversion process requires that you create a new file 
to contain the converted sound. This ensures that the original soundfile 
will remain unchanged. 

To convert a soundfile from one sampling rate to another: 

• Open the soundfile you wish to convert. 

• Choose SR Convert in the DSP menu. The Sample Rate Convert 
window will appear. 
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The Sample Rate Convert window 

• If necessary, use the pop-up soundfile menu to select the soundfile 
you wish to convert. 

•Type in the sample rate of the new soundfile, or type in a ratio 
between the new and the original sample rate. 

• When you are ready to create the new file, dick on the Convert 
button. A save dialog will appear. 

• Type in the name for the new soundfile, choose its file format, and 
click on the New button. 

After a moment the newly created soundfile will appear in a Soundfile 
Window. If you want to verify its new sample rate, choose the File 
menu's Get Info ... command to open an info dialog containing pertinent 
soundfile information. 
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Common DSP Functions 

One of the most important aspects of working with Sound Designer 
II' s DSP functions is the ability to apply them destructively or non­
destructively. Non-destructive editing is optimal for hard disk record­
ing where you might want the original data to remain intact. Destruc­
tive application of DSP would be necessary if the soundfile is to be 
downloaded into a digital sampler or if more DSP functions are 
desired than can be accommodated simultaneously. 

Many of Sound Designer 11' s DSP tools-such as Parametric EQ 
Graphic EQ, Compressor /Limiter, Expander, and Noise Gate-share 
common concepts and functions such as the B-ypass, Use for playback, 
Pre:uiew, and Process options. Let's take a moment to become familiar 
with these concepts before working with the remaining DSP functions. 

Applying the DSP Settings Permanently 
The digital EQ and Dynamics settings can be permanently applied to a 
file. This is a destructive process-the soundfile data will be perma­
nently altered. 

To permanently apply a DSP setting to the file or selection: 

• Establish the setting you wish to commit to. 

• Click on the Process button. The setting will be applied to the 
current selection, or to the whole soundfile if there is no 
selection. 

Applying DSP Settings Non-destructively 
Sound Designer II' s realtime non-destructive DSP functions are 
applied for playback only. The soundfile is not altered, making this the 
best processing method for hard disk recording. 
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To engage DSP for playback only: 

• Oick on the Use for playback box in the processor window. The 
DSP function will be applied during playback until it is turned 
off. 

You will always be able to tell when a DSP function is being used for 
playback, because a diamond (u) will appear in front of it in the DSP 
menu. 

To tum off a DSP playback setting : 

• Choose the appropriate processor command from the DSP 
menu to open its control window. 

• Oick on the Use for playback box to remove the X. The DSP 
function will no longer be applied. 

Comparing Processed and Unprocessed Versions 
It is often desirable to compare the results of the current DSP settings 
with the original file. 

To compare processed and unprocessed settings: 

• Oick on the Bypass box to place an X in it. DSP processing will 
be disengaged 

• Oick again on the Bypass box to remove the X. DSP processing 
will be re-engaged. 

Making Fader Adiustments 
Many of Sound Designer's DSP functions incorporate on-screen faders. 
Course adjustments can be made by simply dragging the faders to the 
desired position. Finer adjustments in values can be made by holding 
down the Option key while dragging. 
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NOTE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 

Parametric EQ 

Sound Designer Il's Parametric EQ functions much like its hardware 
counterparts, allowing you to alter the equalization curve of any 
sampled sound at a specific frequency with pinpoint accuracy. The 
Parametric EQ window offers five equalization filter types, each with 
their own particular parameters. Here are brief explanations of each: 

High-pass filtering. A high-pass filter is essentially a filter that passes 
high frequencies through, but removes (attenuates) low frequencies. It 
is used to remove unwanted low frequencies. When you are using the 
Parametric EQ window to build a high pass filter, only one parameter 
is available: cutoff frequency. Theoretically, all frequencies above the 
cutoff frequency are let through, and all frequencies below it are 
removed. In practice, the cutoff is never perfectly sharp. The actual EQ 
curve is always indicated in the Parametric EQ window's filter graph. 

Low-shelf filtering. A low-shelf filter is one that boosts or cuts the 
level of all frequencies below a certain frequency, but leaves those 
above that frequency untouched. It is generally used to adjust the 
overall low end of a sound. When you are using the Parametric EQ 
window to build a low-shelf filter, two parameters are available: 
corner frequency, and boost/cut amount. Theoretically, only those 
frequencies below the corner frequency are adjusted by the amount (in 
dB) you specify in the boost/cut parameter. In practice, the comer is 
never perfectly sharp. The actual EQ curve is always indicated in the 
Parametric EQ window's filter graph. 

Peak/notch filtering. The characteristics of peak and notch filters are 
very similar. A peak filter is one that boosts only a specific frequency, 
or range of frequencies, while leaving all other frequencies untouched. 
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A notch filter reduces the level of a specific frequency or range of 
frequencies. Both filters are used to adjust only a specific part of a 
sound's harmonic spectrum. When you are using the Parametric EQ 
window to build a peak or notch filter, three parameters are available: 
center frequency, bandwidth, and boost/ cut. The center frequency 
always indicates the actual location of the peak or notch. The band­
width shows the actual number of frequencies that will be adjusted 
(half on either side of the center frequency). Boost/cut determines if 
your filter will be a peak (boost) or a notch (cut) filter. 

High-shelf filtering. A high-shelf filter is one that boosts or cuts the 
level of all frequencies above a certain frequency, but leaves those 
below that frequency untouched. It is generally used to adjust the 
overall high end of a sound. When you are using the Parametric EQ 
window to build a high-shelf filter, two parameters are available: 
comer frequency, and boost/ cut. 

Low-pass filtering. A low-pass filter is one that passes low frequencies 
through, but removes high frequencies. It is generally used to decrease 
the presence of unwanted high frequencies. When you are using the 
Parametric EQ window to build a low-pass filter, only one parameter 
is available: cutoff frequency. 

Adjusting Parametric EQ 
Parametric EQ can be applied to a selection or the entire soundfile. EQ 
may be applied to either channel or both channels of a stereo file. 
Multiple EQ passes may be made on a single soundfile if one filter type 
will not suffice. 

To use the Parametric EQ functions: 

• Make sure that the soundfile you wish to equalize is open, 
then choose the Parametric EQ command. The Parametric EQ 
window will appear. 
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The Parametric EQ window 

• Use the "Soundfile" pop-up menu to select the soundfile (or 
selection) to equalize. 

• Oick on the button corresponding to the channel(s) whose EQ 
parameters you wish to adjust (left, right or both). The right 
and left channels can each have different settings. 

• Oick on the icon for the type of filter you desire. 

• Adjust the volume of the soundfile by dragging the Vol fader 
up or down. This is your actual input volume setting. If you 
are boosting overall power, or leaving power approximately 
the same, you should decrease the input volume so the output 
does not clip. Hold down the Option key before you drag for 
higher resolution on the slider. 
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• Adjust the parameters of the EQ filter to your liking. To do 
this, you can either type values into the text boxes, or drag the 
corresponding mini-faders. 

•Watch the filter response window to see your filter perfor­
mance. This window is actually performing a real time FFf 
analysis that shows you the true performance of your filter. 

•Use Bypass and Preview to audition the EQ. Use Process to 
apply the EQ destructively and select Use for playback to apply 
it non-destructively whenever playback from hard disk occurs. 
These parameters are documented earlier in this chapter under 
"Common DSP Functions." 

Saving the Parametric EQ Settings 
EQ settings can be saved with the Sound Designer II application, or 
with individual soundfiles. This does not apply the EQ settings 
destructively to the file. 

To save the EQ setting with the soundfile: 

• Oick on the Settings button. The Settings dialog will appear. 

Settings In: Sound Designer 11 ... 

Underwater EQ 

~ ~ Telephone Line 

(Delete J 

(seue Rs) 

g ~ 
@ Rppllcetlon O Sound Fiie 

Seue settings es: 

!Razor Edge I 

The Settings dialog 
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• Click on the Sound File button. An open dialog will appear, 
allowing you to select a soundfile where the EQ will be saved. 

• Type in a name for the EQ, then dick on the Save As button. 

Settings you might use for a variety of sessions can also be saved with 
the Sound Designer II application. 

To save the EQ settings with the Sound Designer II application: 

•Click on the Settings button. The Settings dialog will appear. 

• Click on the Application button. An open dialog will appear, 
allowing you to choose a name for the current settings. 

• Type in a name for the EQ, then click on the Save As button. 

Restoring Parametric EQ Settings 
Use the same basic procedure to retrieve a previously-saved EQ 
setting. 

To retrieve a saved EQ setting: 

•Click on the Settings button. The Settings dialog will appear. 

• Choose the source of the EQ (Application or Sound File), 

• Select the EQ, by name and click on the Open button. 

NOfE: Previously-saved EQ settings can also be deleted by clicking 
Delete instead of Open. 

NOfE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 
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Graphic EQ 

Like Parametric EQ Sound Designer II's Graphic EQ emulates its 
hardware counterpart. Graphic EQ allows you to alter the overall 
equalization curve of any sampled sound. Graphic EQ can also be used 
destructively or non-destructively. Destructively altering sample data 
would be used for sounds destined for digital samplers. Non-destruc­
tive EQ is used for real-time equalized playback of hard disk record­
ings where permanent changes to the sample data are not desired. 

The Programmable Graphic EQ window offers ten bands of Graphic 
EQ for mono soundfiles, and five bands of Graphic EQ per channel for 
stereo soundfiles. Each band is set to boost or cut a specific frequency 
and bandwidth in the soundfile's harmonic spectrum. Unlike the 
Parametric EQ the Graphic EQ allows you to create several peaks or 
notches at one time. Since the frequency and bandwidth of each band 
can be adjusted, you can think of it as a 5-band Parametric EQ. The 
trade off here is that the Graphic EQ offers no real-time FFf analysis 
tools, and only gain can be adjusted during realtime previewing. 

To use the Graphic equalization functions: 

• Make sure that the soundfile you wish to equalize is open. 

• Choose the Graphic EQ command in the DSP menu. The 
Programmable Graphic EQ window will appear. 
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The Graphic EQ window 

•Use the Soundfile pop-up to select the soundfile (or selection) to 
equalize. 

• Gick on the button corresponding to the channel(s) whose EQ 
parameters you wish to adjust (left, right, or both). Left and 
right channels can have different EQ curves. 

• Adjust the input volume of the soundfile you're previewing by 
dragging the Vol fader up or down. 

• Adjust the level of each frequency band to your liking by 
dragging each single band fader up or down. Alternately, you 
can drag across the entire fader display to create the EQ curve 
you want. Use Bypass and Preview to audition your changes as 
described earlier in this chapter under "Common DSP Func­
tions". Hold down the Option key before you drag the slider 
for higher resolution. 

Sound Designer II 



IMPORTANT 

• Oick on the Flat button if you wish to set all boost/ cut values 
to zero. 

• Double-click on the number below any fader to alter the 
frequency or bandwidth. A dialog appears. Simply enter the 
desired value(s) and click on OK. 

• Use Process to apply the EQ destructively or select Use for 
playback to apply it non-destructively whenever playback from 
hard disk occurs. These parameters are documented earlier in 
this chapter under "Common DSP Functions." 

NOTE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 

Dynamics 

Sound Designer II' s Dynamics functions allow you to control the 
dynamic characteristics of soundfiles by manipulating the ratios of 
their overall loudness and softness. Like its digital EQ functions, 
Sound Designer II' s Dynamics functions can operate destructively and 
non-destructively. 

Sound Designer II provides you with three types of dynamic effects: a 
Compressor /Limiter, an Expander, and a Noise Gate. 

Compressor/Limiter. In simple terms, the Compressor /Limiter 
reduces a soundfile's dynamic range by decreasing the volume of loud 
(high level) signals. It is useful in cases where your soundfile has a 
very wide range of dynamics (both very loud and very soft sections) 
and you wish to "average" its overall volume. 
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Expander. The expander's function is the opposite of that of the 
compressor /limiter: It increases the dynamic range of a soundfile by 
making soft sections softer. 

Noise Gate. The Noise Gate's function is to "gate" or cut off audio 
signals that fall below a user-selectable threshold. It is typically used to 
reduce residual noise in a soundfile. 

Common Dynamic Functions 
The Compressor /Limiter, Expander, and Noise Gate all share a 
common window and similar controls. 

Input. As its name suggests, the Input fader allows you to change the 
input value of your soundfile's signal. It has a minimum value of-60 
dB (very little signal input) and a maximum value of 0 dB (full signal 
input). 

Detection. The Detection fader allows you to choose how Sound 
Designer II detects whether or not the soundfile' s signal goes over the 
level set in the threshold parameter. With peak detection, Sound 
Designer II looks at the value of individual samples as they are played 
back; in average detection it looks at the average energy of the signal 
over several milliseconds. The latter method is more similar to the way 
that the human ear measures sound. The fader allows you to use either 
method, or a variable mix of both. 

Threshold. The Threshold fader adjusts the dB level at which the 
Dynamic effect takes place. For instance, if you set the fader to -35 dB, 
any signal below* -35 dB would be affected. It has a minimum value of 
-60 dB (almost all signals will be processed) and a maximum value of 0 
dB (no signals will be processed). 

*NOTE: The Compressor /Limiter will affect all signals above the 
threshold. 

Attack. The Attack fader adjusts the amount of time it takes in millisec­
onds before the Dynamic effect becomes fully active. It basically has a 
smoothing effect on the processing. The fader has a minimum value of 
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0.00 ms and a maximum value of 100.00 ms. Greater values will 
lengthen the reaction time of the detection mechanism and hence 
lessen the overall dynamic effect applied. 

Release. The Release fader adjusts the amount of time it takes in 
milliseconds before the dynamic processing dies away. Again it has the 
effect of smoothing the transition between processed and non-pro­
cessed signals. It has a minimum value of 0.00 seconds and a maxi­
mum value of 20.00 seconds. Greater values will lengthen the amount 
of time it takes for the signal to return to its unprocessed state and 
hence smooth dramatic changes. 

Ratio. The Ratio fader adjusts the overall amount of the Dynamic effect 
applied to a soundfile. In compression, a ratio of 13:1 would mean that 
each 13 dB increase in input would yield only 1 dB increase in output. 
Greater values decrease the overall dynamic range of a soundfile. The 
opposite is true of expansion-an expansion ratio of 1:6 would yield 6 
dB increase in output for every 1 dB increase in input. Greater values 
increase the overall dynamic range of a soundfile. (Ratio is not appli­
cable to the Noise Gate.) 

Output. As its name suggests, the Output fader allows you to adjust 
the output of your soundfile's signal. It has a minimum value of -60 dB 
and a maximum value of 26 dB. 

Using Dynamics Effects 
All of Sound Designer H's Dynamics DSP effects are controlled from a 
common window. 

To use the dynamic effects: 

• Make sure that the soundfile you wish to process is open, then 
choose the Dynamics command from the DSP menu. The 
Dynamics window will appear. 
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D namics 

Soundfile: I Multimedia Fanfare I 
-60-~ -15 -8 -6 -4 -2 0 

Function: ® Compressor/Limiter O EHpander O No.ise 6ete 

Avg Slow Slo'W oo:t Max 

Min PHI< Lo"W hst Fast 1 :I Min 

Input Detect Thresh. Attack Release Rntio Output 
OdB OdB 0.00 ms 1.00 sec 3.00:1 0.00 d8 

(Preuiew) (Process) D Bypass D Use for playback 

The Dynamics window 

• Click on the button corresponding to the desired function: 
Compressor/Limiter, Expander, or Noise Gate. 

• Use the Soundfile pop-up menu to select the soundfile (or 
selection) to process. 

• Adjust the parameters of the effect by dragging the sliders. Use 
the Preview and Bypass options to help audition your changes 
as described earlier in this chapter under "Common DSP 
Functions". Hold down the Option key before dragging the 
slider for higher resolution. 

• Use Process to apply the effect destructively or select Use for 
playback to apply it non-destructively. These parameters are 
documented earlier in this chapter under "Common DSP 
Functions." 
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IMPORTANT 
NOTE: Due to the DSP processing power required to implement these 
effects, you will not be able to use other DSP functions in real time 
simultaneously. 

FFT Analysis 

FFf analysis is the process of using the Fast Fourier Transform to 
determine the frequency spectrum of a sampled sound. The transform 
is able to look at any sampled sound and figure out what sine waves 
make up that sound, and how the presence of those sine waves 
changes over time. The results of FFf analysis are commonly dis­
played on a 3-D (XYZ) graph with frequency, amplitude, and time 
along the three respective axes. 

The ability to examine the frequency spectrum of a sound can aid in 
many sound design tasks. In particular, knowing the frequency 
content of a soundfile can give you important insight into its EQ 
requirements. 

To use Sound Designer H's FFf analysis tools, you'll need to familiar­
ize yourself with two separate commands. The Setup menu's Frequency 
Plot ... command is used to set all of the characteristics of the FFf 
display, and the DSP menu's Frequency Analysis command actually 
generates the FFf display. Each of these commands is explained 
below. 

Frequency Analysis Setup 
Although the actual FFf analysis is shown in an FFT window, the 
characteristics of the window are adjusted using the Frequency Plot ... 
command in the Setup menu. The FFf setup dialog has a number of 
parameters that each have a number of options. 
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Bands. The Bands: box allows you to choose how many frequency 
bands will be used to display the plot. When you choose a higher 
number of bands, you increase the density of frequency resolution, 
thereby generating more displayed frequencies and smoother lines. 
Remember that more bands require more time to compute and display. 

Frequency Range. Sound Designer II lets you select the range of 
frequencies that will be included in the FFT analysis. With All selected, 
the FFf analysis shows all detected frequencies from under 20 Hz to 
over 20 kHz. This gives you an overall snapshot of the sound, but 
misses much of the intricate information. (Many sounds don't have 
much frequency energy above 3 kHz.) By selecting a specific range of 
bands to view, you can zoom in and view fewer frequencies at a higher 
resolution. 

Amplitude. The amplitudes can be viewed on either linear or logarith­
mic scales. The Linear scale shows you actual linear amplitude values, 
which will usually appear more subtle, and average much lower peak 
levels. The Log setting uses a logarithmic amplitude scale that empha­
sizes the slope of amplitude peaks, and generally produces visual 
results closer to what the ear hears. 

Direction. The frequency plot can be displayed either forward or 
backward with regard to perceived screen depth. The backward 
setting shows you time slices beginning with the starting point in the 
back and projecting forward in time toward the front of the display. 
The forward setting shows you time slices beginning with the starting 
point in the front and projecting forward in time toward the back of 
the display. 

Type. There are four different types of FFf displays you can choose. 
Mesh emphasizes amplitudes in both time and frequency domains. 
Time isolates the envelopes of specific frequencies over time. Frequency 
isolates the frequency envelopes of each time slice. Chart shows you 
simple vertical amplitude lines indicating all time and frequency data 
points. 

Sound Designer II 



Time interval. The time interval determines how much of the wave­
form will be analyzed and displayed. Shorter time intervals show you 
less of a sound's spectral evolution, but with a higher time slice 
density. Longer time intervals display more of the overall sound, but at 
a lower time slice density. 

To set the parameters for FFr analysis: 

• Select the Frequency Plot ... command from the Setup menu. The 
Frequency Plot dialog opens. 

Frequency Analysis Setup 

Bends: ~ O All ®from LJ to [!O 
Amplitude: l Log I Time lnteruel: ~ msec 

Direction: Backward I 
Type: Mesh 

The Frequency Plot dialog 

• Use the Bands: pop-up menu to choose the number of fre­
quency bands you wish to generate for the FFf window. 

• Oick on the All button to view all frequencies OR click on the 
From button and enter the range of frequency bands you wish 
to display. 

• Use the Amplitude: pop-up menu to choose the type of ampli­
tude scale you wish to see in the FFf window. 

• Use the Direction: pop-up menu to choose whether time will be 
displayed front-to-back, or back-to-front. 

• Use the Type: pop-up menu to choose the type of FFf graph 
that will be displayed in the FFf window. 

Destructive Editing and DSP 123 

II -



124 

• Type in the time interval from the selected soundfile that will 
be displayed. 

• When you have adjusted the frequency analysis settings to 
your liking, dick on the OK button. 

The settings of the Frequency Plot ... dialog are used each time the DSP 
menu's Frequency Analysis command is selected in the DSP menu. They 
can be altered at any time and the current settings are stored with the 
soundfile the next time it is saved. 

3-D Frequency Analysis Display 
The FFT window is useful whenever you need specific information 
about a sound's harmonic structure. In particular, it is a flexible tool 
for diagnosing corrective EQ settings. 

To generate a 3-D FFf analysis of the current soundfile, choose the 
Frequency Analysis command on the DSP menu. An FFT window will 
appear: 

FFT of Microwaue Cots 

Tirnot 

0.00 1.72 3.44 S.16 6.88 8.60 10.32 12.04 13.76 kHz 

The FFT Analysis display 
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The FFT window shows you how the current soundfile' s frequency 
spectrum evolves over time. The X-axis shows the different frequen­
cies, the Y-axis shows the changing amplitude of those frequencies, 
and the Z-axis is time. The specific characteristics of the display 
depend on the settings you have chosen using the Setup menu's 
Frequency Plot ... command. 

Time Compression and Expansion 

Sound Designer 11' s time compression and expansion tools allow you 
to adjust the duration of any sampled sound without changing its 
pitch. This is a particularly important new function for those working 
in audio post-production environments, because it allows sounds to be 
adjusted to specific time or SMPfE durations for synchronization. 
Time compression/ expansion works best when the range of compres­
sion/ expansion is small (less than 20%). Compression or expansion of 
greater than 20% (for speech) or 5% (for music) may result in poor 
sound quality. 

To time-compress or time-expand a soundfile: 

• Open the soundfile you wish to compress or expand. 

• Select the portion of the sound file that you want to compress 
or expand. If no selection is made, the entire file will be 
compressed or expanded. 

• Choose the Time Comp/Expand command on the DSP menu. 
The Time Compression/Expansion window appears. 
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Time Compresslon/EHpanslon 

Soundflle: I Uolce Duer (phrase) 

Current Length: 4.44494 

Desired length: I ~00000 
Time Ratio: j 1.12497 I 

secs 

I secs 

Guide Tract: 
Ci) Left 
QRlght 
O Center 

r- Options:-----------------

High Quality ----•D Hccurate length 4 

High Quality D nccurate Timing 1000 

Unpltched D Pitched 5000 

( Compress/EHpand J 

The Time Compression/Expansion window 

• If necessary, use the Soundfile pop-up menu to select the 
soundfile you wish to time-compress or expand. 

• Type the required duration of the processed soundfile in the 
Desired Length box, or enter a ratio between the new length and 
the current length in the Time Ra.tio box. These two values are 
inter-related-changing one will change the other. 

• Select Left or Right, or Center (left + Right) as the ~uide Track 
if you are processing a stereo file. Sound Designer II will 
optimize the time compression process for this track. If you 
are processing stereo music, try using Center. If you have a 
stereo file with different types of audio on each channel (voice 
right, Sound effects left, for example), try using either Left or 
Right as the Guide Track 
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• Use the High Quality/Accurate Length slider to weight this 
parameter towards which of these qualities you wish to give 
priority to in the time compression/ expansion process. 
Weighting the slider towards "High Quality" generally means 
that there will be fewer audio artifacts and better sonic quality. 
Weighting the slider towards "Accurate Length" puts the 
emphasis on compressing/ expanding the time of the soundfile 
to your desired time specification as closely as possible-at the 
possible expense of fidelity. 

• Use the High Quality/Accurate Timing slider to weight this 
parameter towards which of these qualities you wish to give 
priority to in the time compression/ expansion process. 
Weighting the slider towards "High Quality" generally means 
that there will be fewer audio artifacts and better sonic quality. 
Weighting the slider towards "Accurate Timing" puts the 
emphasis on keeping the tempo consistent in rhythmic 
soundfiles such as music. 

• Use the Unpitched/Pitched slider to indicate which type of audio 
you will be processing, Pitched (music or singing), or 
Unpitched (drums, etc.). For speech, a setting somewhere 
between these two extremes will probably work best, though 
as with the other sliders, you should probably experiment to 
find the optimal settings in each case. 

• When you have finished entering all of the parameters, click 
on the Compress/Exparul button to process the sound file. 

If you do not have enough memory left to Undo the compression/ 
expansion, Sound Designer II will display a dialog indicating this and 
allow you to cancel the operation. You may then either increase 
memory allotment or create a copy of the file before processing. 

NOTE: Time compression and expansion produces its best effects on 
speech and other narrow-band material, such as solo instruments. 
Compression or expansion of broad-band music may reveal undesired 
artifacts. 

Destructive Editing and DSP 127 

II -



128 

IMPORTANT 
The Time Compr~ion/Expansion module requires that the selected 
audio be no shorter than 256 samples in length and no longer than 3 
minutes in length-before or after proc~ing. The smallest time ratio 
allowed for Time Compression/Expansion is 0.5. The largest time 
ratio allowed is 2.0. 

It is generally better to do several smaller ration passes on a soundfile 
than to try to do one large ratio pass. 

NOTE: Normalizing a selection before Time Compressing/Expanding 
it can sometimes help produce better sounding results. 

Pitch Shift 

Sound Designer 11' s Pitch Shift function allows you to adjust the pitch 
of any sampled sound with or without changing its duration. This is a 
very powerful function which essentially allows sounds to be trans­
posed a full octave up or down in pitch without altering playback 
speed. Like Time Compression/Expansion, this feature yields the best 
results when the range of transposition is relatively small (less than 4 
semitones). Pitch shifts of greater than 4 semitones (speech) or 1 
semitone (music) may result in poor sound quality. 

To use Sound Designer II's Pitch Shift function: 

• Open the soundfile you wish to pitch shift. 

• Select the portion of the sound file that you want to transpose. 
If no selection is made, the entire file's pitch will be shifted. 

• Choose the Pitch Shift command in the DSP menu. This opens 
the Pitch Shift window. 
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•l Pitch Shift 

Soundflle: I I ®Left 
Uocal FIH Gulde Tracie: O Right 

Fundamental Frequency: 55 Hz 0 Center 

Tuning Reference: Pitch Shift: 
181 Time Correction 

~ Coarse Fine 

+ t 
TC Ratio: 1.015 

~~=~·= l 440.00 I 
Note: I R4 I (Process) 

(Master Tune) LI ~ (Preulew) 
Semitones Cents 

The Pitch Shift window 

• If necessary, use the Soundfile pop-up menu to select the 
soundfile you wish to pitch-shift. Sound Designer II will 
automatically display the fundamental frequency of the 
selected soundfile. 

• Select the Guide Track option if you are processing a stereo file. 
Sound Designer II will optimize the pitch shifting for this 
channel. 

• Check the Time Correction box if you do not want the time 
duration to change. This function utilizes the Time Compres­
sion/Expansion module's current settings, so make sure that 
they are set appropriately for the type of audio you are pro­
cessing (pitched/unpitched, etc.). 

• Adjust the pitch by dragging either of the two faders, or by 
typing values in the boxes below them The Coarse slider 
transposes in semitones (half steps); the Fine slider transposes 
in cents. 
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Although you may select time correction in this window, it is not 
available in Preview mode because of the extremely complex DSP 
calculations required for its implementation. 

• If you find a pitch shift setting you wish to make permanently to the 
soundfile, click on the Process button. 

The Pitch Shift window provides a simple tuning reference. Oick on 
the speaker icon to hear the reference tone. To change this tone, enter a 
new value or click on the pop-up Note menu, drag the mouse along the 
miniature keyboard, and let go at the desired note. It is possible to tune 
this reference tone by clicking the master tune button and dragging the 
fader, or by typing values into the box. Finer adjustments can be made 
by holding the option key while dragging the fader. 

By clicking the time correction check box you have the option of 
enabling or disabling time correction. If time correction is disabled, 
playback speed will increase proportionally as the soundfile is trans­
posed up in pitch and decrease proportionally as it is transposed down 
in pitch. 

Summary 

This chapter has covered most of Sound Designer H's destructive 
editing and DSP functions. The next chapter explores using Sound 
Designer II to edit files for use with digital samplers. 
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Working with Samplers 
and Sample Editing 

Introduction 

In addition to hard disk recording, the Sound Designer II software 
provides sample editing for many popular digital samplers. 

Sound Designer II allows you to edit and audition samples before 
sending them to a sampler, however it is generally a good idea to 
transmit the sounds to the sampler and audition them on the sampler 
itself before you sinish your editing session. Sound Designer II re­
quires a standard MIDI interface in order to communicate with an 
external MIDI sampler. 

Connecting the MIDI Interface and Samplers 

Everybody's work environment is unique, and for this reason your 
particular MIDI setup may differ from that of another user. Although 
you may be using a more complex MIDI setup, here is an illustration of 
the bare basics of a working MIDI chain: 
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~~ 

IN 
O OD .....__ _ ____. 

DO 

MIDI Sound Module 

MIDI IN 

OUT OUT 

I MIDI Interface 
IN 

I 

MIDI Controller 

To Modem or 
Printer port 

I 
MIDI OUT 

A basic MIDI chain 

D 
Macintosh 

NOTE: If you have a hardware MIDI patch bay, it should be inserted 
into your MIDI chain between your MIDI interface, and all of your 
sampling devices. Be aware that some MIDI patch bays may cause 
intermittent communication problems with some samplers. 

Configuring Sound Designer II for MIDI 

To configure Sound Designer II for your MIDI setup: 

• Choose the MIDI Interface ... command in the Setup menu. The 
MIDI Interface dialog appears. 
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Select Serial Port(I): Interface 
Clock Rate: 

~ 
Q500KHz 

181 Modem Port @) 1MHz OMIDI Thru 
Q2MHz 

~ 
Q500KHz 

O Printer Port @) 1MHz 0MIDI Thru 
02MHz 

QD 

The stamlard MIDI Interface dialog 

NOTE: If you are using MIDI Manager, the following dialog will 
appear instead: 

Select MIDI Interface Clock Rates: 

rw1 ~ 0 500KHZ ® 1 MHz 0 2MHz 

l~I 0 500KHz ® 1 MHz O 2MHz 

( OK J 

The MIDI Manager interface dialog 

• Check the box in front of each serial port (Modem and/ or 
Printer) that you plan to connect to your MIDI Interface. 

• Oick the radio button in front of the clock rate that corre­
sponds to that of your MIDI interface. This will generally be 1 
MHz, but you should check your interface's manual for 
specific information. 

• Check the MIDI Thru box for each interface if you want it to 
retransmit incoming MIDI data back out of the MIDI output. 
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• Oick the OK button when you are done. 

NOfE: If the serial port you wish to use for MIDI is in use by 
Appletalk, you must first "release" it by selecting Chooser from the ti 
menu, and clicking Appletalk's Off button. Similarly, any other pro­
gram or driver using a port intended for MIDI must release the port. 
See the documentation of any applicable programs. 

Defining Your Samplers 

Sound Designer II allows you to have multiple samplers connected to 
your Macintosh simultaneously. Without touching any hardware, you 
can select each sampler as the source or the destination for a sampled 
soundfile. Before you can send and receive sampled sounds, you will 
need to add those samplers to your personal sampler list. 

To configure Sound Designer II for your samplers: 

• Choose the Sampler ... command on the Setup menu. The 
Sampler dialog box appears. 
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Samplers: Port: Format: 

Akal S1000 (SCSI) #I 

~ 
®Modern D~IOI . O Printer osc~• 

Roland S-550 # 1 181 RS-422 

~ Deuice ID: D 
( Rdd ) (Delete J SCSI ID: ~ 

( OK ) 

The Sampler dialog 

• Oick the Add button to show a list of supported samplers. The 
Add Samplers dialog appears. 

Select a Sampler: 

11 111 

AkeiS900/S950 
Akai 51000 (SCSI) 
Casio FZ-1 /FZ-1 OM 
E-mu EmoH 
E-mu EmBH II 
E-mu Emulator 11 
E-mu Emulator 111 

( Open J 

(Cancel J 

The Add Samplers dialog 

• Select the name of the sampler you wish to add to your 
personal communication list. 
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• Oick the Open button. You will be returned to the original 
Sampler ... dialog box. The name of the selected sampler will be 
added to the Samplers list. 

• While the sampler is still selected, click the button in front of 
the correct port (Modem or Printer) and communication format 
(MIDI, SCSI, or RS-122) that describes the new sampler. 

• While the sampler is still selected, type in a Device ID or SCSI 
ID for the new sampler. Generally your device ID will be the 
sampler's send and receive MIDI channel. However, unlike 
MIDI channel settings, system exclusive standards allow more 
than 16 device IDs. SCSI ID is the SCSI device number of a 
SCSI-equipped sampler. Consult your sampler's manual for 
more information. 

• When all of your samplers appear in the Samplers box and are 
configured properly, click OK. 

More than one of the same type of sampler may be connected at the 
same time, but make sure that no two samplers have the same commu­
nications settings and device numbers. Remember, you can change the 
setting of any sampler by selecting it and adjusting the settings as you 
desire. However, some samplers will not allow you to adjust their 
device ID number. 

Sending and Receiving Samples 

Once you have configured Sound Designer II and added your 
sampler(s) to your personal sampler list, you are ready to send and 
receive sounds. 

To receive a sound from a sampler: 

• Select the source sampler from the list displayed when you 
choose the Sampler ... command on the Setup menu. 
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• Choose the Sampler->Mac command on the File menu. 

• Select the sound you wish to retrieve from the sampler. Once 
again, each sampler has different communications abilities, so 
these functions will vary from sampler to sampler. 

• Oick the OK button to retrieve the sound. When the entire 
sound has been received, it will appear in a new Soundfile 
Window. 

To send a sound to a sampler: 

• Open the soundfile using the File menu's Open ... command. 

• Select the destination sampler from the list displayed when 
you choose the Sampler ... command on the Setup menu. 

• Choose the Mac->Sampler command on the File menu, or click 
on the Mac-to-Sampler icon. A dialog box similar to this will 
appear: 

Mac -> Sampler Fiie Transfer 

Send: Mnc File: Uoice Duer Femnle 2 

Length: 3968 

To: [Q]Sound: D 
lQJLength: Juicy Splat 

[ Cancel 

The Mac->Sampler dialog 
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• Set the destination characteristics (sample ID number, channel, 
etc.) for the sound you're sending. Each sampler uses different 
terminology, and has different communications abilities, so 
these functions will vary from sampler to sampler. 

• Oick on the OK button to begin the transfer. 

Looping 

El 
All of the destructive editing techniques and Soundfile Window 
features discussed earlier in this manual can be applied during sample 
editing. 

Sound Designer II employs a number of looping tools and functions 
that greatly simplify the creation of smooth loops. Although most 
sampling devices are capable of one or two loops, some can play back 
up to eight loops in a single soundfile. To facilitate this, Sound De­
signer II allows you to create an unlimited number of loops in any file. 

Because of this multiple-loop capability, you'll need to remember that 
loop number 1 is always the sustain loop, and loop number 2 is always 
the release loop. Your sampler will only receive the number of loops it 
can play back. The same limitations are imposed for the two loop types 
that are available within Sound Designer II' s loop environment. 
Although any loop can be created as a forward or forward/backward 
loop, only certain sampling devices are capable of playing forward/ 
backward loops. You may want to consult your sampler's manual for 
specific information on its looping capabilities. 

Remember these import ruyles when you are creating and playing 
back loops with Sound Designer II: 
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• A loop must fit in memory, therefore loops that are more than 
several seconds in length will not play back on the Mac. 

• The Direct from disk option must be turned off for a loop to play 
back (see the Setup menu's Sound Playback ... command). 

• Loop points will always be the same across all channels of a 
stereo sound file. 

• Original Sound Designer format files (not Sound Designer II) 
will only save loops 1 and 2 regardless of the number of loops 
you have created. 

Creating a New Loop 

To create a loop in Sound Designer II: 

• Oick on the Loop Start Marker icon. The mouse cursor will 
change to a Loop Start cursor whenever it is positioned over 
the waveform that you're editing. 

• Oick the Loop Start cursor at the desired loop start point 
within the waveform. A loop start marker with the number 1 
will appear. 

• Select the Loop End Marker icon. The mouse cursor will 
change to a Loop End cursor whenever it is positioned over 
the waveform that you're editing. 

• Oick the Loop End cursor at the desired loop end point within 
the waveform. A loop end marker with the number 1 will 
appear at the bottom of the waveform display, along the time 
line. 
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You have now created a working sustain loop. To listen to it, switch to 
selection mode (using the Range Select icon), and hold down the 
Speaker icon. Unless you are extremely lucky, you'll probably find that 
your loop is far from perfect. 

If the timbre of your loop changes radically at the loop splice point, 
you'll probably want to try new loop points. The simplest way to edit 
an existing loop is to drag its loop markers to a new position in the 
Soundfile Window. 

Using the Loop Window 

If the loop is basically good, but is marked by clicks, pops, volume 
bumps, or a slight timbral bump across the splice, you can probably fix 
it using Sound Designer's Loop window. The Loop window is de­
signed to fine-tune basic loops that you've already created using the 
Loop Start and Loop End icons. 

NOTE: The Loop window cannot be activated unless both Loop Start 
and Loop End markers have been defined. 

To open the Loop window: 

• Choose Loop from the Tools menu. The Loop window will 
appear. 
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I Loop 1 I I Channel 1 

The Loop window 

The waveform on the left side of the display is the loop end, and the 
waveform on the right is the loop start. The vertical line dividing them 
is the loop splice point, where playback jumps from loop end to loop 
start. 

If you want to create a high-quality loop, you must make sure that the 
slopes and general shapes of the waves on both sides match, and the 
transition at the splice point is smooth. Here are brief explanations of 
the Sound Designer II Loop window tools that can help you to build a 
quality loop: 

Speaker button 
Click and hold the mouse pointer on the Loop window's Speaker 
buttonto hear the loop played back. 

Display Scale Arrows 
These arrows adjust the resolution (zoom) of the Loop window's 
waveform display. They function in exactly the same way as the 
Soundfile Window's View Adjustment Arrows: only the view is 
adjusted, not the sample data. 
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Crossfade button 
The Crossfade button is one of Sound Designer 11' s most important 
looping tools. Click on it to open this dialog box: 

Crossfede Looping 

tro11fade Type: @) Linear 
O Equal Power 

Loop Type: @Forward 
O Backward/Forward 

MaHimum Length: 41122 Samples 

Crossfode Length: 1141122 I Samples 

Cancel (Continue) 

The Crossfade Looping dialog 

The Crossfade Looping dialog allows you to design and execute a 
crossfade loop. Crossfade looping is a sample editing technique that 
uses a sound's own natural waveform evolution to "smooth over" the 
loop splice point. 

Essentially, Sound Designer 11' s crossfade looping takes a copy of the 
loop end waveform and crossfades 50% of it with 50% of the loop start 
waveform. Then it takes the original loop start waveform and 
crossfades 50% of it with 50% of the loop end waveform. By doing this, 
it ensures that the loop end and loop start waveforms match, although 
neither has been radically changed. 

In order to ensure that all transitions play back smoothly, including 
those before the loop start and after the loop end, the crossfades are 
centered right over the loop start and end points. The length of the 
crossfade determines how much waveform on either side of the loop 
points will be involved in the crossfade. For this reason, crossfade 
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length must be shorter than the total length of the loop, shorter than 
the length of waveform between sound beginning and loop start, and 
shorter than the length of waveform between loop end and sound end. 

Linear uses flat (linear) crossfade curves, and is better for most applica­
tions. Equal Power uses a non-linear fade curve which may be of use if 
you find that the center of your crossfade areas drop in volume. 

The Crossfade Loop dialog supports both Forward and Forward/ 
Backward loops. Most samplers employ Forward loops. Consult your 
sampler manual to determine if it can play back Forward/Backward 
loops. 

To execute a crossfade loop: 

• Oick on the Loop window's Crossfade icon. The Crossfade 
Looping dialog will appear. 

• Oick on the button in front of the desired crossfade type. 

• Oick on the button in front of the type of loop you're creating. 

• Type in a value in the Crossfade Length box if you want a 
setting other than the default maximum length. (The maxi­
mum length is indicated in the dialog.) Generally speaking, the 
maximum crossfade length will produce the best results. 

• Oick on the Continue button to execute the crossfade. 

NOTE: It is generally a good idea to create the best possible loop 
before resorting to crossfade looping. For more information on creating 
good loops easily, see the description of the AUTO arrows. 

Information button. Clicking the Info button opens a dialog box that 
tells you all of the pertinent information about the loop you're cur­
rently working on. In the dialog box you'll find the name of the 
soundfile, the current channel number, the loop number, the loop start 
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and end positions, and the loop type. If you wish, you can use this 
dialog to change loop start and end positions, and loop type. When 
you are done editing or viewing the information, click the OK button 
(to make changes), or the Cancel button to abort. 

Pop-up loop selection menu. The number of the loop you're editing is 
always indicated across from the icons at the top of the Loop window. 
To edit a different loop, click and hold on the loop number box. A pop­
up menu will appear and you can select another loop to edit by 
choosing its number and letting go of the mouse button. Remember, 
only loops that have both a defined start and a defined end point will 
appear. 

Pop-up channel selection menu. The number of the channel you're 
seeing in the Loop window is always indicated to the right of the loop 
number. To see how the same loop affects a different channel, click and 
hold on the channel box. A pop-up menu will appear and you can 
select another channel to view. Remember, loops are always the same 
from channel to channel, so you can't adjust a loop point in one 
channel, without adjusting it in all other channels. 

Left and right scroll arrows. The left and right scroll arrows located 
below the loop end and loop start waveforms are used to move the 
actual loop points from within the Loop window. The left arrows 
move the loop points toward the soundfile beginning, and the right 
arrows move the loop points toward the soundfile end. 

SHORTCUT: To bring any displayed waveform spot to the splice 
point, just click on that waveform spot in the Loop window's wave­
form displays. 

Left and right AUTO arrows. The left and right AUTO arrows are 
particularly useful loop point positioning tools. Rather than just sliding 
the loop points to the right or left in small increments, the AUTO 
arrows automatically move the loop point to the next point that 
preserves both the value and the slope of the splice. If you're adjusting 
the loop end, the AUTO arrow matches the loop start. If you're adjust­
ing the loop start, the AUTO arrow matches the loop end. For this 
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reason, you can almost be assured of the best possible loop transition if 
you adjust your loops with the AUTO arrows. 

NOTE: Some sounds with an extreme amount of harmonic evolution 
will simply not have any acceptable natural looping points. These 
sounds are prime candidates for crossfade looping methods. 

Deleting Loops 
It's easy to remove a loop at any time if necessary. 

To delete a loop: 

•Make sure you're looking at the Soundfile Window. 

• Drag the loop start and loop end markers you wish to delete to 
Sound Designer II' s Trash. This will delete the loop perma­
nently. 

Summary 

This chapter has covered the basic functions associated with sending, 
receiving, and looping files in conjunction with digital samplers. The 
next chapter describes how to synchronize Sound Designer II to 
SMPTE time code. 
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Working with SMPTE 

Introduction 

This chapter covers the basics of using Sound Tools II with SMPTE and 
explains the commands and functions needed to achieve proper and 
accurate synchronization of Sound Tools II to an external source. If 
you are unfamiliar with SMPTE or with the principles of synchroniz­
ation, please refer to the Appendix of this manual. There you will find 
an explanation of SMPTE and SMPTE frame rates as well as instruc­
tions for setting up your Sound Tools II system to properly synchro­
nize with SMPTE. 

Sound Designer II and the Macintosh only understand MIDI time 
code (MTC), which is the MIDI version of SMPTE time code. SMPTE is 
an analog signal, and MTC is a digital signal. Therefore, you cannot 
feed standard SMPTE signals directly into your Mac for synchroniza­
tion. You need a SMPTE to MTC converter (such as Opcode System's 
Studio 3, JL Cooper's PPS-1, etc.) to allow your computer to under­
stand SMPTE. For more information about SMPTE and MTC, see the 
Appendix. 
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Preparing your System 

Before you proceed, your Sound Tools II system should be properly 
connected with your external synchronization devices. If you haven't 
made the appropriate connections, do so now by referring to the 
following illustrations. These show two possible setups for synchro­
nizing Sound Tools II to video tape. The first setup utilizes Sound 
Designer II's Continuous SMPTE Sync feature to achieve synchroniza­
tion. The second setup utilizes Digidesign's Video Slave Driver (avail­
able separately). 

Setup A 

II I CDODOD 

_ Video Tape Recorder 

SMPTE f OR ~ vrrc Video out 

VITC to MIDI Time 
Code Convertor 

Video out Composite I I MID/Tims 
Cods out 

To Printer or 
Modsmport 

D g 
RGB Monitor Macintosh 

(Continuous SMPTE resync on) 

Audio Interface 

Synchronizing with Continuous SMPTE Sync 
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Setup B 

Blackhurst Generator To video sync input 

1

._I ____ I ca::JDD 

.__ ___ _,,,.,...__•_•_• __ I Video Tape Recorder 

vL1ave on- I I 
=rt ;_T JT al):J tsMPTE OR t VITCVidooout 

/_ VITC to MIDI Time 
Audio I nteiiace Code Convertor 

!
MIDI Tims 
Code out 

To PrintBf or 
Modem port 

!c:=:~ 

______ o g 
Macintosh RGB Monitor 

(Continuous SMPTE resync off) 

Synchronizing with the Video Slave Driver 

Choosing a SMPTE Frame Rate 

Your first task in preparing Sound Tools II for synchronization is 
choosing a SMPTE frame rate 

SMPTE Fonnats 
Sound Tools II supports all current SMPTE frame rates. These rates 
are: 24 frames per second (FPS), for film; 25 FPS for P AL/SECAM 
video; 29.97 FPS for NTSC color video; 29.97 drop FPS for wall-clock 
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accurate broadcast NTSC color video; and 30 FPS that is generally used 
only for time stamping synchronization in audio-only applications. 
Make sure that you know without a doubt which of these formats your 
project's tape has been striped with before you begin your session. A 
little extra care up front is always preferable to hours spent redoing 
work later. 

To choose a SMPTE format: 

' 
• Select Set Current Time ... from the Setup menu. This dialog 

appears (if the menu item is disabled, click in the waveform 
display to create an insertion point instead of a selection): 

The Insertion point Is at: 

SMPTE Feet + Frames Bars/Beats 

I 00:00:01.13 I 2 + n 

Q 24 FPS 0 16 mm Time Sig.: 

EJ1 EJ 025 FPS ®35 mm 
030 FPS Drop 
®30 FPS ND Tempo: 
0 29.97 FPS ND I 120.000 

(Capture J OK 

The Set Current Time ... dialog 

• Select the SMPTE frame format appropriate to your session. 

• OickOK. 
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Displaying Time in SMPTE Frames 

The next step in preparing Sound Tools II for synchronization is setting 
the Time Scale to SMPTE. Though Sound Designer II will still syn­
chronize to incoming SMPrE time code if the Time Scale is displayed 
in other formats (such as Hr:Min:SecMsec), it is obviously more useful 
to use SMPTE frames as your reference. 

Setting the Time Scale to SMPTE frames: 

• From the Setup menu, choose Scale Marks ... This dialog ap­
pears: 

• Select SMPTE. 

• OickOK. 

Select Weueform Scales: 

Uertlcel Scales: 

® Percent Full Scale 
O Quantized Sample Uelue 

Horizontal Scales: 

QTime 
0 Hr.Mln:Sec.Msec 
O Dec1111el Semple Number 
0 HeH Semple Number 
®SMPlE 
O Feet+Fremes 
O Bers I Beets 

The Scale Marks .. dialog 

Alternately, you can hold down the Option key and click on the Time 
Scale to bring up this pop-up menu: 
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Time 
Hr:Min:Sec.Msec 
Sample Numbers 
HeH Sample Numbers 

Option-clicking on the Time Scale brings up this pop-up menu. 

Sound Designer II will now display time in the currently selected 
SMPTE frame rate. 

Choosing a Synchronization Mode 

Your next task is to choose a synchronization mode for your session. 
Sound Tools II provides two types of synchronization: SMPTE Trigger 
and Continuous SMPTE Sync. Each of these has its advantages and 
disadvantages. 

SMPTE Trigger 
SMPTE Trigger is Sound Designer II's default synchronization mode. 
In this mode, when Sound Designer II is placed "on line", the system 
waits for incoming SMPTE to "trigger" or begin playback. When it 
receives SMPTE, it begins playback using only its own internal crystal 
oscillator (which is very stable) to control playback speed. 

Unfortunately, if the playback speed of your master sync source is not 
perfectly stable, there is a potential for trouble witb,this method. 
Sound Tools II's audio will be triggered in perfect sync with the master 
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source, but it may not remain in sync because the master source's 
playback speed is fluctuating relative to the crystal oscillator in the 
Audio Interface. If the audio regions triggered with Sound Tools II are 
short (30 seconds or less) there probably won't be a noticeable prob­
lem. But if they are lengthy, the master source and Sound Tools II 
could get farther and farther out of sync as playback progresses. 

Continuous SMPTE Sync 
Continuous SMPTE Sync is Sound Tools II's other synchronization 
mode, and can be enabled in the Sound Playback dialog. In this mode, 
playback of Sound Tools II is also triggered by incoming SMPTE. 
However, in this case, Sound Tools II is constantly looking at incoming 
SMPTE frame numbers and adjusting its playback sample rate to 
compensate for any discrepancies in the timing of the master sync 
source. 

However, just as with Trigger, if your master sync source is very 
unstable, there is a potential for poor results. In this case, the real-time 
sample rate conversion that Sound Tools II must perform in order to 
stay locked with your master source may cause the fidelity of your 
digital audio playback to suffer. This audio degradation can range 
from very subtle to very noticeable, depending on how poor your 
master sync source is. The best way to avoid this type of problem is to 
obtain a rock-solid master sync source. 

NOTE: Because of the DSP processing power required to implement 
the Continuous SMPTE Sync feature, you will not be able to implement 
real time DSP functions such as Graphic EQ and Dynamics. 

A third, better synchronization alternative exists. This technique uses 
SMPTE Trigger but maintains long-term synchronization with the 
Video Slave Driver, available separately from Digidesign. If you are 
involved in professional audio production, Digidesign recommends 
that you use this optional peripheral with your Sound Tools II system 
for professional quality synchronization. 
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The Video Slave Driver 
The Video Slave Driver is a peripheral device for Sound Tools II that 
allows you to calibrate Sound Tools H's recording and playback clock 
to an external video black burst or word clock signal. The Video Slave 
Driver accepts either of these signals and then converts it into a master 
clock signal which it sends to the Audio Interface. By sending the 
same master black burst clock signal to Sound Tools II and your video 
deck, all elements of your system will run at exactly the same speed, 
thereby staying in sync. 

In this case, (SMPTE) Trigger is the method used and SMPTE Time 
Code is only used to locate, chase, and trigger. Playback speed of both 
Sound Tools II and the video tape recorder are then controlled by the 
black burst signal. This technique will produce better audio quality 
than Continuous SMPTE Sync with fluctuating sync signals, and will 
ensure that the Sound Tools II system will remain tightly locked to the 
sync source. 

In summary: 
You have three choices when synchronizing Sound Tools n to an 
external source: 

1) Using Trigger with the optional Sound Tools II Video Slave 
Driver to control Sound Tools Il's recording/playback speed 
(and the master SMPTE source's playback speed) with a black 
burst generator. 

2) Using Trigger by itself (which could result in timing errors if 
you have lengthy audio regions and a very unstable sync 
source). 

3) Using Continuous &sync (which could result in audio degra­
dation if you have a very unstable sync source). 
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To choose a synchronization type: 

• Choose Sound Playback ... from the Setup menu. This dialog 
appears: 

.-- Sound Playback Options -

Gil sound Rcceleretor• .. 

181 Direct from disk 
181 Continuous SMPTE Sync 
0 Use Dither 

O Sound Drluer 

O Sound Manager 

Choosing a sync mode 

• If you wish to use Continuous SMPTE Sync, click its box in this 
dialog. An ''X" indicates that it is enabled. 

• Alternately, if you wish to use SMPTE Trigger, turn off Con­
tinuous SMPTE Sync by clicking and removing the ''X" from 
the Continuous SMPTE Sync box. Sound Tools will default back 
to SMPTE Trigger mode. 

• If you are using Digidesign's Video Slave Driver, make sure 
that Continuous SMPTE Sync is off and refer to your Video 
Slave Driver owner's manual for additional instructions. 
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SMPTE Offset 

The SMPTE Offset ... command is used to compensate for short SMPTE 
offsets associated with some hardware connected in the SMPTE path. 
In a normal working environment, this command will probably never 
be used. However, if you feel that you are experiencing SMPTE offsets 
(either delayed triggering or early triggering), use this feature. 

To choose a SMPTE trigger offset for your session: 

• From the Setup menu, choose SMPTE Setup ... This dialog 
appears: 

SMPTE trigger offset: l~I msec 

(cancel) OK 

Entering a SMPTE Offset 

• Type in a value in milliseconds (between -10 and 10 msec 
should be sufficient). 

• OickOK. 

Putting Sound Tools II On Line 

In order to trigger playback of Sound Tools II from an external source, 
you must put the system on line. In this state, it waits for incoming 
SMPTE frame . When Sound Tools II sees SMPTE time moving 
forward, it will begin audio playback or recording. 
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To put Sound Tools II online: 

• From the Setup menu, choose On-line. A check appears in front 
of the command to indicate on line status. At the same time, 
the large Current Position Indicator box at the upper right of the 
Sound Tools II window will display the current SMPTE frame 
location of your incoming Time Code. 

Or: 

• Oick the Tape Deck icon to make the Record dialog appear. 

• Oick the On line box in this dialog. This method is most often 
used if you plan to trigger Sound Tools II's direct to disk 
recording with SMPI'E (covered later in this chapter). 

Sound Tools II is now on line and waiting for SMPTE time code to 
trigger playback. 

To take Sound Tools II off-line, choose On-line from the Setup menu 
again, or open the Record dialog and click to remove the "X" from the 
On line box. 

NOfE: While Sound Designer II is on line, pressing the Spacebar on 
the keyboard will not cause audio to playback. The system must be off 
line to play audio with either of this method. You can play back by 
clicking the speaker icon or holding down the mouse button in the 
overview. 
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Synchronizing Audio Playback to SMPTE Frame 
Locations 

One of the most common and useful applications of audio synchroni­
zation is its use in audio post production to "spot" or assign music and 
sound cues to specific SMPrE frame locations in a film or video. 
Sound Tools II provides a convenient method for doing this and can 
spot: 

1) Playback of an entire audio file, the start point being defined in 
the main Waveform Display with the Set Current Time ... 
command. 

2) Playback of an entire Playlist, by setting a SMPTE start frame 
for the first region occurring in the Playlist. 

3) Playback of specific regions within a Playlist, by assigning 
specific SMPTE times to each region to be triggered within the 
Playlist. 

By simply identifying a location in your audio file and entering an 
appropriate SMPTE frame number in a dialog box, Sound Designer II 
will then trigger the audio upon receipt of SMPTE time code. 

Though SMPTE frame numbers can be typed into dialog boxes, the 
process is much faster (and less error-prone) if you are using Vertical 
Interval Time Code (VITC). In this case you can immediately "capture" 
a frame location by pushing the Capture button in the dialog. 

NOTE: Be aware that although the Capture button will work with 
Longitudinal Time Code (LTC), frame numbers of a paused frame can 
only be accurately captured with VITC. This is because LTC, being on 
the audio track, is NOT refreshed when a tape is paused or played at 
very slow speeds-such as those used when "crawling" through a 
video to isolate "hit" points. 
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NOTE: When spotting a region, the time entered in the Spot Region ... 
dialog must not be less than or 12 hours greater than the SMPTE start 
time of the playlist itself. 

To spot an entire audio file with SMYfE: 

• Identify the SMPTE frame location where you wish to trigger 
playback of your audio by pausing your video deck on that 
frame. 

• In the Soundfile window, locate the exact spot in the audio file 
that should correspond with the video frame you are paused 
at. 

• Oick the Selector at this spot. 

• From the Setup menu, choose Set Current Time. This dialog 
appears: 

The Insertion point Is at: 

SMPTE Feet • Frames 

1100:00:11.1 o I n • oo 

0 24 FPS 0 16 mm 
0 25 FPS ® 35 mm 
030 FPS Drop 
®30 FPS NO 
0 29.97 FPS ND 

(Capture) OK 

Bars/Beats 

Time Sig.: 

(!]I (!] 
Tempo: 

1120.000 

The Set Current Time dialog 

• Type in the desired SMPTE frame location or Click Capture. 
The current frame's SMPTE number appears in the boxes. 

• OickOK. 
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The audio file is now spotted to the chosen SMPTE frame location. 
When the system is On line, SMPTE will trigger playback of the audio 
file. 

To spot an entire Playlist to a specific SMPTE frame : 

• Identify the SMPTE frame location where you wish to trigger 
playback of your audio by pausing your video deck on that 
frame. 

• In the Playlist window, double click the Start Time box of the 
FIRST region to appear in the Playlist (or choose SMPTE Start 
Time ... from the Playlist menu). 

The Start Time Box 

This dialog appears: 

Set SMPTE Time: 

100:00:10.011. [] 

hr:mn:sc:fr 1 /4 Frm 

OK J (Capture) ( Cancel ) 

The Start Time dialog 
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• Type in the desired SMPTE frame location or Click Capture. 
The current frame's SMPTE number appears in the box. 

• OickOK. 

The Playlist is now spotted to the chosen SMPTE frame location. 
When the system is On line SMPTE will trigger playback of the Playlist. 

NOTE: When the system is on line, the Playlist window's Stop button 
says Play, and incoming SMPTE is indicated in the upper right corner 
of the window. The Playlist will remain this way until SMPTE start 
time code triggers playback of the playlist. 

To spot a single region to a specific SMPTE frame: 

• Identify the SMPTE frame location where you wish to trigger 
playback of your audio by pausing your video deck on that 
frame. 

•In the Playlist window, double click the Start Time box of the 
region you wish to spot. 

• Type in the desired SMPTE frame location or click Capture. The 
current frame's SMPTE number appears in the box. 

• OickOK. 

The region is now spotted to the chosen SMPTE frame location. When 
the system is On line SMPTE time code will trigger playback of the 
region. 

Repeat as necessary for other regions in the Playlist. 
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Unlocking Time Locked Regions 

After you have spotted a region, it automatically becomes "time 
locked" to the specified SMPTE frame and cannot be moved even if 
other regions are added to the Playlist. This is to prevent you from 
inadvertently moving its position in a Playlist. Regions which are time 
locked appear in bold face type in the Playlist to be easily recognized. 

A locked region cannot be moved from its location in the Playlist 
unless you "unlock" it with the Un-Timelock Regions command in the 
Playlist menu. 

Start Ti me ~Region 

.Q.Q.:.9..1:.Q.9. ... 9..Q. ~I~.P. ........................................ . 
00:04:01 .03 Chuctle .................................................................................... 
00:04:01.07 Car Horn .................................................................................... 

A time locked region appears in bold face type 

To unlock a timelocked a region: 

• In the Playlist, click on the region you wish to un-timelock (or 
Shift-click and select multiple regions). 

• From the Playlist menu, choose Un-Timelock Regions. The 
regions are now unlocked and can be moved from their 
current positions. 

NOTE: Simply selecting a region and pressing the Delete key will NOT 
remove the time-lock; it will simply remove the region from the 
Playlist and cause the region following the deleted region to be moved 
down into the locked region's position. 
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Triggering Direct to Disk Recording with SMPTE 

Another useful application of SMPTE synchronization is triggering 
direct to disk recording from Sound Tools II. By doing this, music and 
sound cues can be recorded digitally by Sound Tools II in sync with 
the playback of additional material on multi track tape or video. 

To trigger direct to disk recording at a specific SMPTE frame: 

• Identify the SMPTE frame location where you wish to trigger 
Sound Tools H's direct to disk recording. 

• Oick the Tape Deck icon to open Sound Designer's Record 
dialog. This dialog appears: 

Fiie Name: Digital Uocal Ouerdub 

Semple Rete:I 44100 I ~ ~:~:o 
Rec. Source: Rudio Interface Rnalog Input 

Record start: I oo:oo:ll!l!Jll 
Record Stop: I 00:03:24.00 1181 On Line 

Length: 

Current: 

Ruallable: 

Time 

00:00:00.00 

OO:OO:OO.OO D Pre-Rllocnte 

Buffer Size: lel 00:00:28.00 ~ 

••••••• RTZ REW PLAY STOP FF CiiTE REC 

The Record dialog 
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• Make sure that the On Line box is checked. 

• Enter the desired SMPTE start frame location in the Record 
Start box. 

• Enter the desired SMPTE end frame location in the Record Stop 
box. 

•Gick OK. 

When Sound Tools II receives the SMPTE Record Start frame number it 
will begin recording. It will stop recording when it receives the SMPTE 
Record Stop frame number. If no number is entered in the Record Stop 
box, Sound Designer II will only stop recording if you stop it manu­
ally. 

WARNING: If you are using SMPTE to trigger recording in a file that 
already contains audio, be aware that Sound Tools II will begin 
recording at the current playback location in the file. To avoid record­
ing over valuable material, use the Tape Deck dialog's Go to End button 
to navigate to the end of the current audio file before putting your 
system on line. 

Troubleshooting SMPTE 

Making SMPTE synchronization work properly can seem difficult at 
times. Here are some things to look out for when things don't seem to 
be going right. 

(1) Striping SMPTE after music has been recorded 
All tape machines in your setup (both audio and video) absolutely must 
have been striped with SMPTE Time Code before any audio is re­
corded onto them or to the Sound Tools II system. Not doing so is like 
trying to write data on a hard disk without formatting it first. The 
system may seem to work, but synchronization will never properly 
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occur. The machines and Sound Tools II will drift farther and farther 
apart the longer they run. 

The same problem occurs when audio is recorded onto Sound Tools II 
without any SMPTE sync (if, for example, it was recorded before the 
current session). The audio cannot be accurately synchronized with an 
analog tape recorder or video tape deck, since the original audio on the 
Mac was not recorded based on the SMPTE Time Code from the 
analog tape deck or video tape deck. 

(2) Not knowing the actual frame rate on your tape 
You may think this unlikely, but if you get your video tapes from a 
production company instead of recording them yourself, you are at 
their m~rcy as to what SMPfE frame rate is actually used on that tape. 
It may have been incorrectly labeled. Worse, it may be different than 
the frame rate of the SMPTE you have already striped on your audio 
tape! Be absolutely sure you know what SMPTE frame rate is used on 
any material you work. with. 

(3) 29.97 FPS Non-Drop can be difficult 
29.97 FPS Non-Drop is achieved by sending the 30 FPS non-drop time 
code slightly slower. When used with color video, each video frame 
now matches up with each SMPTE frame without having to use a 
drop-frame coding. This makes any frame number mathematics much 
simpler, since no frame numbers are dropped. 

The problem is, many hardware and software devices do not recognize 
this frame rate. The Apple MIDI Manager, for example, still does not 
explicitly recognize it. The user must tell the MIDI Manager to expect 
30 FPS non-drop instead. In fact, most devices that read SMPTE work 
acceptably reading 29.97 non-drop if they are set to expect 30 FPS non­
drop. That is why this format has achieved such popularity. 

Unfortunately, any SMPTE reader that uses the time code numbers to 
make real-time calculations (as Sound Tools II does when it tries to 
trigger and sync to SMPTE) also needs to know that the frame format is 
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29.97 and not 30 FPS. Since Sound Tools Il allows this choice of frame 
rate this does not really pose a problem. The problem exists because 
the user cannot readily distinguish 29.97 from 30 FPS. More impor­
tantly, many production companies will distribute video work prints 
striped with 29.97 FPS but mark them as "30 FPS NTSC", by which they 
actually mean 29.97 FPS. By the time the tape gets to you, you may 
have no idea what's on it. Feeding 29.97 non-drop to Sound Tools II 
when it's set for 30 FPS non-drop will result in timing errors of about 
1.8 frames per minute. 

(4) Appletalk, networks and screen savers cause problems 
These types of software can cause the Macintosh to ignore MIDI data 
(such as MIDI Time Code) coming into its serial ports. The net effect of 
this is that an application (such as Sound Tools II) will appear to lose 
SMPTE lock and sync, and drop in and out of lock repeatedly, every 5 
or 10 seconds. Make sure Appletalk is inactive in the Chooser, discon­
nect Appletalk cables, and remove any INIT-based network software 
from your System folder (QuickMail, Microsoft Mail, AppleShare, TOPS, 
etc.). 

(5) Resolve all components of your system, if possible 
When striping time code, make sure that the time code generator and 
the record deck are resolved to the same crystal reference. For ex­
ample, when striping 29.97 Drop Frame time code onto a VTR, both 
the SMPTE generator and the VTR should be resolved to the same 
''black burst" or house sync generator. During playback, the master 
deck should be resolved to ''black burst" or house sync. This conven­
tion provides compatibility for your tape between the record and 
playback passes, and when it's played back in other facilities on 
different equipment. This also means that when playing back a tape 
striped with time code, the playback deck should be resolved to the 
same sync rate as the record deck was resolved to at the time of the 
striping. 
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(6) Be careful when changing frame rates 
If you change time code rates in the middle of a session, many SMPTE­
to-MIDI Time Code converters need to be turned off and turned on 
again to be able to read the new frame rate correctly. 

(7) Consistent use of clock sources in Sound Tools II 
A soundfile should be played back using the same peripheral and 
sample rate it was recorded with, if at all possible. This assures the 
closest match between record and playback sample rates. For ex­
ample, if an audio file was recorded at 44.1 kHz with the Sound Tools 
II Audio Interface then the Sample Rate should be set to 44.1 kHz 
during playback with the Audio Interface as well. 
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The Fila Menu 

Sound Designer 11' s File menu contains all of the commands you'll use 
to create and maintain your soundfiles. Here are brief explanations of 
each command. 

New... XN 
Open... •o 
Open Resource ... 
Close •w 
Mee -> sampler 
Sampler -> Mee 

Sill'0 :•:S 
Seue e Copy ••• 
Reuer t to Sat•ed 
Delete ••• 

Page Setup ••• 
Print .•• 

&et Info... XI 
lransfel" ... 
Quit acq 

New ... [311] 
The New ... command is used to create a new soundfile from scratch. A 
new (and therefore empty) soundfile is used to record a new hard disk 
recording or as a paste destination for sample data currently on the 
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Clipboard. Choose one of the soundfile formats, mono/ stereo format, 
name the soundfile, and click the New button. Here are brief explana­
tions of the available file formats: 

Sound Designer. The Sound Designer file format is the standard 16-bit 
mono format used by the original Sound Designer program. It is useful 
for file exchange with programs that support only the Sound Designer 
files. 

Sound Designer II Mono. The Sound Designer II file format is a 16-bit 
mono format recommended for use with DECK digital multitrack 
recording software or mono files that require more than 10 markers. A 
mono soundfile not saved in this format will lose all markers above the 
10 supported in the original Sound Designer file format. 

Sound Designer II Stereo. The Sound Designer II file format is the 
default 16-bit stereo format employed by this program. It is the recom­
mended stereo recording file format. 

AIFF. The AIFF file format is Apple's Audio Interchange File Format, 
and is a variable-resolution, multi-channel soundfile format. Use it to 
exchange soundfiles between programs, but do not use it for hard disk 
recording. The AIFF format can be used to create and store mono files. 

NOTE: Compressed and Resource formats must be created using Save 
As. Some options are not available with certain file formats. 

Open ... 
The Open ... command lets you open any compatible soundfile for 
editing and playback in Sound Designer II. When the Open ... dialog is 
on your screen, check the box in front of every file format you wish to 
look for. (See the New ... command for information about the different 
formats.) Use the dialog to navigate to the folder that contains your 
soundfile and click on Open. 
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Open Resource .. . 
The Open Resource ... command is used to open Macinotsh SND 
Resource files. Resources are embedded within documents and appli­
cations, so the Open ... dialog will show documents and applications, 
instead of showing only soundfiles. 

Close 
The Close command performs the same function as the Oose Box in the 
active window's title bar. It closes the active file or window, thereby 
removing it from the screen. If you attempt to close any soundfile 
which contains changes that have not been saved, a warning dialog 
will appear, allowing you to save your changes. If you click No, your 
changes will not be saved. 

NOTE: Files that have "No Backup" in their title bar will retain all 
waveform edits, regardless of whether you choose to save before a 
closing or not. However, you must still save the file to retain Playlist 
edits, EQ settings, loop and marker changes, and similar edits. 

Mac -> Sampler 
The Mac -> Sampler command performs two functions. If a soundfile is 
open, it does the same thing as the Mac-to-Sampler icon present at the 
top of its soundfile window. If no soundfile window is open, it brings 
up an Open ... dialog. Use the Open ... dialog to select the file you wish 
to send directly to the currently selected sampler and access it transfer 
options. (See the Setup menu's Sampler ... command for more informa­
tion about selecting a destination sampler.) 

Sampler-> Mac 
Use the Sampler -> Mac command to retrieve a sound from the sampler 
that has been selected with the Setup menu's Sampler ... command. 
When you choose the Sampler-> Mac command, the standard transfer 
dialog appears. Use the transfer dialog to choose the sound you wish 
to retrieve from the selected sampler. The retrieved sound will appear 
in a new soundfile window. 
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Save 
The Save function operates differently depending upon the Use Backup 
Files setting in the Setup menu. With Use Backup Files engaged, the 
changes you have made since your last save are stored over the old 
version. Once you have saved, you cannot use the Revert to Saved 
command to return to the soundfile's original form. With Use Backup 
Files disengaged, all non-destructive edits are saved. Destructive edits 
have been made directly to the soundfile, so they do not need to be 
saved. 

Save a Copy ... 
The Save a Copy ... command saves a copy of the currently selected 
soundfile under a different name or in a different format. To save a 
copy of the soundfile, choose the destination disk and folder, type in 
the name of the new file, and select the desired format options, then 
click on Save. 

NaJ'E: Not all options are available in all formats. 

The Compressed file format utilizes a technique called adaptive differen­
tial pulse code modulation to compress Sound Designer II files at the ratio 
of 2:1 or 4:1. When compression is selected, a dialog appears in which 
the compression may be selected and previewed. This format is useful 
for saving files when hard disk space is limited. Please be aware that 
by compressing a soundfile you are actually reducing the amount of 
sample data contained in the file, thus comprt>mising its audio fidelity 
to some degree. 

Clicking on the Resource button saves the file as a Macintosh SND 
Resource-a standard 8-bit Macintosh System and application format. 
It is used to create soundfiles that can be played back by the Mac 
System (the alert sound, for example) and by certain applications such 
as HypetCard. A dialog will appear with additional options. Use 
Normal to create standard mono 8-bit SNDs for playback on any Mac. 
Use Chunky to create mono or stereo 8 or 16-bit SNDs that can be 
played back both as 8-bit sounds on normal Macs and 16-bit sounds on 
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Macs with a Sound Accelerator II card. Use Interleaved to create mono 
or stereo 8- or 16-bit SNDs that can be played back only on Macs with a 
Sound Accelerator II card. 

Revert to Saved 
If Use Backup Files is engaged, the Revert to Saved command ignores the 
changes you have made since your last save and returns to the old 
version. Remember, once you have reverted to your previously saved 
version, the changes you have made will be lost .. This command is 
disabled if the Use Backup File option is turned off, since all wave data 
edits are made directly to the disk file. 

Delete ... 
The Delete ... command is used to permanently remove a file from a 
disk. Click cancel to exit this dialog. 

Page Setup ... 
The Page Setup ... command brings up the standard Macintosh printer 
Page Setup dialog. The actual dialog depends on the printer that you 
have selected with the ti menu's Chooser. To learn more about these 
settings, click the dialog box's Help button, or refer to your printer 
manual. 

Print .. 
The Print ... command brings up the standard Macintosh Print dialog. 
As with the Page Setup dialog, the actual dialog that appears depends 
on the printer you have selected with the ti menu's Chooser. To learn 
more about these settings, click the dialog box's Help button, or refer 
to your printer manual. 

Sound Designer II allows you to print the active soundfile window, 
FFT window, or Playlist window. Only the currently active window 
will be sent to the printer. 
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Get Info ... 
The Get Info ... command perfonns a function within Sound Designer II 
that is similar to the Finder's Get Info ... command. It displays the vital 
information about the currently selected soundfile., including file size, 
data format, sample rate, and creation and modification dates .Space is 
provided to add general comments about the soundfile. Only the 
sample rate and comments can be edited. 

To change the playback sample rate, click the box next to Sample Rate, 
and type in a new rate. Remember, changing the sample rate simply 
changes the playback rate. If you wish to change a sound's sample rate 
without changing its pitch, use the SR Convert ... command on the DSP 
menu. 

Transfer ... 
The Transfer ... command allows you to quit Sound Designer II and run 
another program without returning to the Finder. This function is not 
available if you are running under MultiFinder. 

Quit 
The Quit command ends your Sound Designer II session, and returns 
you to the Finder or MultiFinder. Although Sound Designer II will 
warn you before allowing you to quit without saving changes, it is still 
a good idea to save your work using the Save or Save As ... command 
before quitting. 

The Edit Menu 

Sound Designer II' s Edit menu contains all of the standard Apple Edit 
commands, as well as a host of specific sound-oriented processing 
commands. Here are brief explanations of each command: 
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c 1m't Undo :•:z 

Cul aH 
Copy ac 
Paste :•:L• 
CIHr •e 
Ret>lnce :•:Y 
Reuene 
Siience ICE 
Tlim ICY 
lnuert 
Fede In 
Fede Out 
Normalize 
Change 6eln ... 

Smoothing 
Select RH ICR 
Show Clipboard 

Undo 
The Undo command is a very useful editing tool. It keeps track of your 
last action and allows you to reverse that action if you don't like the 
outcome. After you undo something, you can ''Redo" it by choosing 
the Undo command again. This is a gocxl way to compare before and 
after tests of any process. The Undo command only tracks the last 
action, so use it with caution. 

NOfE: Some disk-based edits cannot be undone, due to the huge 
amount of data involved. Sound Designer II will always warn you that 
a process can't be undone before allowing you to do it. 

Cut 
The Cut command cuts the selected waveform range out of its current 
position and holds it on the Macintosh Oipboard. The wave data 
previously to the right of the excerpted range is shifted to the right to 
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close the gap. After a waveform range has been cut, it remains on the 
Clipboard until another cut or copy is made, or until the Mac is shut 
down. 

Copy 
The Copy command places a copy of the selected range on the Macin­
tosh Clipboard. After a waveform range has been copied, it remains on 
the Clipboard until another cut or copy is made, or until the Mac is 
shutdown. 

Paste 
The Paste command is only active after sample data has been placed on 
the Clipboard by using the Cut or Copy command. The Paste command 
inserts the Clipboard contents into the current soundfile, beginning 
immediately after the blinking insertion point. If a range is selected, 
the range is deleted prior to insertion of the Paste data. All wave data 
to the right of the paste point is pushed farther to the right to accom­
modate the newly pasted range. Pasting may increase the size of a 
soundfile, and will only be allowed if there is enough disk space to 
accommodate storage of the resulting file. 

If your paste destination has two (or more) channels, and your paste 
source does not have the identical number of channels, a dialog 
prompts you to set the destination channel for each channel you are 
pasting. 

Clear 
The Clear command deletes the selected waveform range from the 
soundfile without placing it on the Oipboard. When a waveform range 
is cleared, the entire waveform area to the right of the range slides over 
so that no gap remains. 
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Replace 
Like the Paste command, the "Replace command is only active after 
sample data has been placed on the Oipboard by using the Cut or Copy 
command. It pastes the Oipboard contents over sample data in the 
current soundfile. If a blinking insertion point is present, the replace­
ment begins at that point and covers all of the wave data required to 
place the entire Oipboard range. If a range is selected, the replacement 
begins at range start and proceeds only to range end. Replacing is 
destructive, in that it overwrites the waveform range covered by the 
new data, but it always preserves the soundfile's overall duration. 

Reverse 
The Reverse command reverses the order of the samples in the range 
and causes it to play backward. Reversing the same range a second 
time will return it to its original form. This command is sometimes 
useful in creating special sound effects. 

Silence 
The Silence command sets the value of all samples in the selected 
waveform range to zero, muting the passage. Unlike the Cut or Clear 
commands, the Silence command does not close up the space it creates. 
Instead, it maintains the space, and therefore the overall duration of 
the soundfile. 

Trim 
The Trim command all waveform data except the currently selected 
range. 

Invert 
The Invert command takes the selected waveform range and turns it 
upside down. This is accomplished by making all positive sample 
amplitude values negative, and all negative ones positive. Inverting a 
waveform range will not change its sound in any noticeable way, but it 

Reference 183 

Cl 



184 

may simplify the creation of certain loops and mixes. Inverting the 
same range a second time will return it to its original form. 

Fade In 
The Fade In command fades in the selected waveform range using a 
linear fade curve. Starting at the beginning of the range, it fades from 
zero amplitude to 100% of the original amplitude at range end. 

Fade Out 
The Fade Out command fades out the selected waveform range using a 
linear fade curve. Starting at the beginning of the range, it fades from 
100% of the original amplitude to z.ero amplitude at range end. 

Normalize 
The Normalize command scales the amplitude of a selected waveform 
range so that its peak value is set to Sound Designer II' s maximum 
peak value. This is particularly useful for sounds that were sampled at 
a low amplitude. 

Change Gain ... 
The Change Gain ... command proportionally increases or decreases the 
amplitudes of all samples in a selected waveform range by a user­
defined amount. The Peak Value button displays the percentage value 
of the highest selected amplitude. The Change Gain ... function has a -
75% to +200% limit in its gain parameter. After the gain change is 
executed, you will be returned to the soundfile window to see the new 
amplitude of your selected waveform range. 

Smoothing 
Smoothing is an editing option that can be toggled on and off by simply 
selecting it. When the smoothing function is turned on, extreme 
instantaneous amplitude changes at the edit points are automatically 

Sound Designer II 



"smoothed over," alleviating click and pop problems. Smoothing is a 
destructive option. 

Select All 
Select All selects the entire soundfile for editing. 

Show Clipboard 
The Show Clipboard command opens a small window that displays the 
contents of the Macintosh Clipboard. In most cases this will consist of 
wave data when you are using Sound Designer II. The Show Clipboard 
command is useful for checking to see what you have on the Oipboard 
for pasting or replacing. The contents cannot be edited or played back 
until placed in a soundfile again. 

The Tools Menu 

The Tools menu offers you access to functions specifically designed for 
sample editing. Here are short explanations of the Tools menu com­
mands: 

XK 
XL 

MIDI Keyboard 
The MIDI Keyboard command presents a musical keyboard-a remote 
MIDI triggering tool that lets you send MIDI note-on and note-off 
messages to the currently selected sampler. This window lets you play 
any MIDI device directly from your Macintosh, and will be of particu­
lar use to owners of rack-mount sampling modules. The keyboard 
currently selected on the Sampler ... menu will always be the destina-
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tion. The Pattern button plays each note sequentially. Record lets you 
enter a specific sequence of notes. Play plays back the recorded pattern. 

Loop Window 
The Loop Window command brings up the window you'll use to fine­
tune loops you have defined with the loop start and loop end markers. 
When the window appears, you will see two waveform ranges divided 
by a vertical black line. The range on the left represents the wave data 
immediately before loop end, and the range on the right is the wave 
data immediately after loop start. The black line is the actual loop 
splice point where loop playback jumps from loop end to loop start. 

For specific directions for using Sound Designer II's loop window, see 
the looping information in Chapter F. 

The DSPMenu 

The DSP menu is your gateway to Sound Designer Il's digital signal 
processing tools The use of each of these DSP commands is detailed in 
depth in Chapter E of this manual. Here you will find short explana­
tions of each. 

MIH 
Merge 
SR Conuert 
Peremetr1c EQ 
Graphic EQ 
Dynamics 

Frequency Analysis 
Time Comp/ENP 
Pitch Shift 
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Mix 
The Mix window allows you to digitally mix up to four mono and/ or 
stereo soundfiles, and save the result as a new soundfile. All aspects of 
the mix can be controlled, including level, stereo pan, input scaling, 
and delay before mix start. To learn more about this function, see 
ChapterE. 

Merge 
The Merge window is Sound Designer II' s crossfade workshop. It 
allows you to open two soundfiles that contain Numbered Markers, 
define the crossfade between them in terms of the markers, and 
execute the crossfade. The product of a merge is a new soundfile that 
begins with one of the original files and ends with the other. All 
aspects of the crossfade between them, including crossfade curve and 
length, can be adjusted. Refer to Chapter E for more specific merge 
directions. 

SR Convert 
The SR Convert command is used to alter the sample rate of a soundfile 
without changing the sound's pitch. Sample rate conversion allows 
you to adjust any sound in your library to any sample rate, so that 
those sounds can be sent to any Sound Designer II-compatible MIDI 
sampler, or made compatible with other devices such as DAT record­
ers. See Chapter E'for more specific information. 

Parametric EQ 
The Parametric EQ command opens the parametric equalization 
window. Use the Parametric EQ window to select, adjust, preview, 
and perform parametric equalization on one or two channels. Five 
different types of parametric filters are available: High pass, low shelf, 
notch/ peak, high shelf, and low pass. Any number of specific para­
metric EQs can be designed and saved either with your Sound De­
signer II program or with specific soundfiles. See Chapter E for more 
specific information. 
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Graphic EQ 
The Graphic EQ command opens the Graphic equali7.ation window. 
Use the Programmable Graphic EQ window to adjust, preview, and 
perform separate 5-band Graphic EQs on each channel of a stereo file, 
or a 10-band Graphic EQ on a mono file. The bandwidth and center 
frequency of each graphic band can be adjusted to provide a virtually 
limitless number of equa1iqtion options. And any number of specific 
Graphic EQs can be designed and saved either with your Sound 
Designer II program, or with specific soundfiles. See Chapter E for 
more specific information. 

Dynamics . 
The Dynamics command gives you control over the overall dynamic 
characteristics (loudness and softness) of your soundfile with three 
different DSP tools: a Compressor /Limiter, an Expander, and a Noise 
Gate. All parameters, inclqding input, output, threshold, attack, 
release, detection, and ratio can be fully adjusted. See Chapter E for 
more specific information. 

Frequency Analysis 
The Frequency Analysis command generates a 3-D Fourier analysis 
display that shows the spectral evolution of the waveform in the 
soundfile window over time. The characteristics of the 3-D display are 
set using the Setup menu's Frequency Plot ... command. See Chapter E 
for more specific information. 

Time Comp/Expand 
The Time Comp/Expand command is used to adjust the duration of a 
soundfile without changing its pitch. This function is particularly 
useful for sound design in audio post-production environments, 
because it allows you to match sounds to time or SMPTE frame 
durations. See Chapter E for more specific information. 
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Pitch Shift 
Pitch Shift is use to adjust the pitch of a soundfile by a user-selectable 
amount. With the Time Correction option selected, it's possible to do so 
without changing the soundfile' s duration. This function is particularly 
useful for audio production applications where pitch correction of 
vocals or instruments is necessary. See Chapter E for more specific 
information. 

The Playlist Menu 

The Playlist menu, along with the Playlist icon, is your door into 
Sound Designer II' s non-destructive editing mode. Play list menu 
commands are only available after the Playlist window has been 
opened by clicking on the Playlist button. The fine points of Playlist 
creation and editing are explained in Chapter D. 

-~ . 
New Pl11yL11t ... 
Open Playllst ••• 
Delete Playlist 
Rename Pleyllst ... 
Seue Pleyllst Rs Soundflle ... _______________________ ___, 
Rename Region ••• 
Edit Regions ... 
Un-Tlmeloclc Regions _______________________ __, 
SMPTE Start Time ••• 
Capture Region aBR 
Preulew Edit 8£P 
Fades... aBF 

New Playlist ... 
The New Playlist ... command is used to create and name a new empty 
Playlist. This command is most useful if you have already defined one 
or more soundfile regions using the Capture Region command. See 
Chapter D for more information. 
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Open Playlist .. 
The Open Playlist ... command is used to open any existing Playlists 
attached to the current soundfile. See Chapter D for more information. 

Delete Playlist .. 
The Delete Playlist ... command is used to delete the Playlist that is 
currently open in the Playlist window. See Chapter F for more infor­
mation. 

Rename Playlist ... 
The Rename Playlist ... command is used to rename the Playlist that is 
currently open in the Playlist window. See Chapter D for more infor­
mation. 

Save Playlist as Soundfile .. . 
The Save Playlist as Sound.file ... command is used to save the currently 
open Playlist as a new soundfile. All non-destructive edits in the 
Playlist-region playback order, fade ins/ outs, crossfades, and so on­
are applied to create a completely new soundfile with these attributes. 
The new soundfile is the equivalent of digitally recording the output of 
a Play list into a new file. This new file will be as long as the Playlist' s 
play time so you may require quite a bit of additional disk space. See 
Chapter for more information. 

Rename Region .. . 
The Rename Region ... command is used to rename the currently selected 
region in the Play list window's region list. See Chapter D for more 
information. 
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Edit Regions ... 
The Edit Regions ... command is used to edit the currently selected 
region in the Playlist area of the Playlist. It brings up a window in 
which all region parameters, including length, volume, crossfade 
duration and crossfade type can be fully adjusted and auditioned. See 
Chapter D for more information. 

Un-Timelock Regions 
The Un-Timelock Regions command allows you to unlock a frame­
locked region that has been selected in the Playlist' s regions list. The 

, region will be placed at the end of the previous region. 

NOTE: A region cannot be un-timelocked by merely deleting it from 
the regions list; doing so will merely cause the region following it to 
take its place, thus becoming time-locked. 

SMPTE Start Time 
The SMPTE Start Time command is used to set the SMPTE start time of 
the first Playlist region. All other regions' SMPTE start and stop times, 
including locked regions, will be adjusted accordingly. See Chapter G 
for more information. 

Capture Region 
The Capture Region command is used to specify a selected range of 
wave data in the soundfile window as a Playlist region. A waveform 
range must be selected in order for this command to be active. See 
Chapter D for more specific information. 
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Preview Edit 
The Preview Edit command serves two purposes: 

If you select a region in the region list at the top of the Playlist win­
dow, the Preview Edit command plays only that region, while display­
ing the waveform range in the soundfile to show what is being played. 

If you select a region in the Playlist area, the Preview Edit command 
auditions the transitions between the region and its neighbors. The 
specified pre-roll and post-roll times are used. This allows you to 
audition the crossfade or transition between regions without having to 
play the entire Playlist. See Chapter D for more specific information. 

Fades ... (3€ - F J 
The Fades command brings up the Playlist Fade Editor window in 
which user-programmable envelopes can be created for fading in and 
out a Playlist. Users can draw their own envelopes from scratch or 
start from two preset types. The duration of fade ins and outs is fully 
adjustable. See Chapter D for more specific information. 

The Display Menu 

Sound Designer II' s Display menu contains the commands you'll use 
to organize your windows, add channels to a file, select windows for 
viewing or editing, search for markers, and display the screen cursor. 
Here are short explanations of the commands on the Display menu. 

Sound Designer II 



Rdd New Channel 

Find Marter... •F 
Screen Cunor 

Tiie Windows 
Steck Windows 

•Untitled 

Add New Channel 
The Add New Channel command adds a channel to a mono Sound 
Designer II or AIFF file. When you are editing a file with one of these 
fonnats, the Add New Channel command adds a new empty channel 
below the existing channel. Once a new channel has been added, you 
can paste any desired waveform into it. This function is limited to a 
maximum of two channels. 

Find Marker ... [3e-F] 
The Find Marker ... command allows users to quickly locate text or loop 
Markers in a soundfile. All text and loop markers placed in a soundfile 
automatically appear in pop-up menus within the Find Markers 
dialog. To find a marker, click on the button in front of the type of 
marker that you wish to find and select it from the pop-up menu 
containing the names of all placed markers of that type. With text 
markers, you have the option of typing in any part of the marker's 
name and Sound Designer II will match the rest of the marker's name 
for you. After you have selected the marker you wish to locate, click 
Find and Sound Designer II will scroll to that location in the soundfile. 

Screen Cursor 
The Screen Curscr command toggles Sound Designer H's large screen 
cursor on and off. Unlike the flashing insertion point, the screen cursor 
is attached to the window, not the waveform. It can be moved within 
the soundfile by dragging its triangular base to the left or right. The 
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screen cursor is a gauging tool that can be used to determine the exact 
time and amplitude values for any single point in the current wave­
form. 

When the screen cursor is moved, the upper and lower right data 
indicator boxes show the time and amplitude values of the current 
point. If a multi-channel file is being edited, the uppermost channel's 
values will be displayed. 

Tile Windows 
The Tile Windows command is very useful for cleaning up your screen 
when you have multiple windows open. All open Sound Designer II 
windows (excluding Mix, Merge, SR Convert, Time Comp/Expand, 
and EQ windows) will be resized automatically to fit on your screen, 
so you can see them all at one time. 

After you have tiled the open windows, you can grow any window to 
full screen size by dicking on the window's Grow Box in the right 
comer of its title bar. Oicking on the Grow Box a second time will 
shrink the window back to its tiled size. 

Stack Windows 
The Stack Windows command is another window clean-up command. 
Each open Sound Designer II window (excluding Mix, Merge, SR 
Convert, Time Comp/Expand, and EQ windows) will be resized 
automatically to fill your screen, and all will be placed in a pile, with 
the active window on top. 

Window List 
Any time Sound Designer II is running, you will see a list of all open 
windows (excluding Mix, Merge, SR Convert, Time Comp/Expand, 
and EQ windows) at the bottom of the Display menu. A diamond 
always appears in front of the active window. To bring any listed 
window to the front and make it the active window, just choose the 
name of that window at the bottom of the Display menu. 
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The Setup Menu 

You will use the various commands on the Setup menu to configure 
the various settings for your Sound Designer II environment. Here are 
short explanations of each command: 

Frequency Plot ••• 
MIDI Interface ••• 
Scale Marts ••• 
Sound Playback ••• 
Hardware Setup... XO 

On-Line 
use Backup Flies 

,,.Scroll Rfter Play 
HDPley Buffer Size... XH 
RRM Buffer Size ••• 
Preferences ••• 
SMPTE Offset ••• 

Set Current Time ••• 
Set lnteruel ••• 
Set Colors ••• 
Sampler ••• 

frequency Plot .. . 
The Frequency Plot ... command is used to set the characteristics of the 3-
D FFf display that is created when you choose the DSP menu's 
Frequency Analysis command. For parameters details, please see 
ChapterE. 

MIDI Interface ... 
The MIDI Interface command lets you set the clock rate of the particular 
MIDI interface(s) connected to your Mac's modem and/or printer 
ports. Most MIDI interfaces use a 1 mHz clock rate, but you will need 
to check your MIDI interface manual to make sure. An incorrect clock 
setting will prevent your MIDI interface from functioning. Check the 
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MIDI Thru box for each interface if you want it to retransmit incoming 
MIDI data back out of the MIDI output. See Chapter G for more 
information. 

Scale Marks ... 
The Scale Marks ... command lets you select the units that you'll see 
displayed on the vertical (Y) and horizontal (X) axes in the active 
soundfile window. Here are short explanations of the different vertical 
and horiz.ontal scale units: 

Percent Full Scale: This unit indicates all amplitudes in percent of 
maximum allowable amplitude values. Values above 100% will be 
clipped. This is generally the most useful amplitude scale for sound 
design and hard disk recording. 

Quantized Sample Value: This unit indicates all amplitudes in the closest 
quantized sample value (between -32768 and 32768). Because this is 
machine-oriented, it is generally of less use. 

Time: This unit indicates waveform duration in minutes, seconds, or 
milliseconds. 

Hr:Min:Sec:Msec: This unit indicates duration in 
hours:minutes:seconds:milliseconds. 

Dedmal Sample Number: This unit indicates duration in decimal sample 
number. Although this unit gives a clearer picture of the memory 
required to contain a sound, it is not useful for normal time duration 
judgements. 

Hex Sample Number: This unit indicates duration in hexadecimal (base 
16) sample number. 

SMPTE: This unit indicates duration in SMPTE time code, according to 
the SMPTE format chosen with the Set Current Time ... command. This 
setting is most useful for video applications. 

Feet and Frames: This unit indicates duration in feet and frames, accord-
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ing to the film format chosen with the Set Current Time ... command. 
This setting is useful for film applications. 

Bars and Beats: This unit indicates duration in bars and beats, according 
to the base unit defined using the Set Current Interval... command. This 
duration unit offers a more "musical" option, but is only useful on 
sequenced or steady meter music. 

SHORTCUT: Hold down the Option key to access a pop-up that allows 
the time scale to be changed quickly. See Chapter C for details. 

Sound Playback .. . 
The Sound Playback ... command is used to set Sound Designer II' s 
soundfile playback to match your system. Here are brief explanations 
of the different playback options: 

Sound Accelerator. This will insure that all mono and stereo 
soundfiles are played through the card at 16-bit resolution. If you click 
on the Direct from disk box, you will set the speaker icon to play back 
directly from the hard disk. When the Direct from disk box contains no 
''X," the speaker icon only plays back the contents of memory. 

NOfE: Direct from disk playback may cause a slight hesitation before 
playback begins, (unless Pre-allocate HD buffers is selected in Prefer­
ences ... under the Setup menu) whereas memory playback is immedi­
ate. Loops cannot be played direct from disk. 

If you plan to trigger playback of soundfiles with SMPTE, check 
Continuous SMPTE Sync. This ensures that Sound Designer II playback 
remains perfectly synchronized to SMPTE throughout playback. 
However, because of the DSP processing power required to implement 
this feature, you will not be able to implement other DSP functions 
such as Graphic EQ and Dynamics in real time. 

Dithering randomizes the effect of quantization error in digital audio 
signals. Select Use Dither when you are editing and manipulating 
soundfiles with DSP functions, such as EQ or when using fade in or 
fade out functions in the Playlist. 
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NOTE: Sound Designer always uses dither in Parametric EQ Graphic 
EQ, and destructive fades. It is never used in Dynamics. Selectable 
dither is only used when DSP is not implemented during playback. 

Check the button appropriate to your interface device. This ensures 
that both the interface's recording electronics and the Sound Accelera­
tor 11' s playback electronics use the same clock. 

Sound Manager. If you are running a Mac II System that uses Apple's 
Sound Manager click on the radio button in front of this option to 
route playback to the Mac speaker. To determine whether you have 
the Sound Manager or the Sound Driver, open the Control Panel on 
the ti menu. Scroll down if necessary and select the Sound icon. If the 
panel that appears offers a choice of alert sounds, you have the Sound 
Manager. If not, you have the Sound Driver. Direct for disk playback is 
not supported. 

Sound Driver. If you are running a Mac System that uses Apple's 
Sound Driver, click on the radio button in front of this option to route 
playback to the speaker. To determine whether you have the Sound 
Driver or the Sound Manager, see the previous paragraph. Direct for 
disk playback is not supported. 

If you are playing back sounds with the Sound Driver, you can choose 
between a fixed playback rate of 22.254 kHz and playback the 
soundfile' s sample rate. There is a trade off attached to this decision. 
The Mac has a fixed playback rate of 22.254 kHz, so it gives up some 
fidelity in order to play back sounds with a different sample rate. If 
you want to hear your sounds at highest 8-bit fidelity, choose Internal. 
The sounds will not, however, be played back at their true pitch. If you 
want to hear your sounds at their true pitch, choose Soundfile Sample 
Rate. In this case, the sounds will not be played back at their highest 
fidelity. 
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Hardware Setup 
The Hardware Setup command brings up a dialog that configures 
Sound Designer II for your hardware system. Select Card Type 
determines which interface card is in the NuBus slot. Current options 
are the Sound Accelerator or Pro Tools Audiocard. For more 
information on Hardware Setup, refer to Chapter B. 

On-Lina 
The On-Line command puts your system into external sync mode. 
Sound Designer II will remain in a play /wait state until the correct 
SMPTE start frame is received. Choose the command again to take 
your system off line. See Chapter G for more information. 

Use Backup Files 
When the Use Backup Files command is checked ( 4 ), Sound Designer II 
will attempt to create a backup copy of any file that is opened. In this 
mode, all edits are made to the copy of the original soundfile, and are 
not saved to the original until the File menu's Save command is chosen. 
This is the safest way to edit soundfiles, because it allows you to close 
a file without saving any changes you have made. To tum this option 
off, just choose the command again. 

NOTE: The Use Backup Files option will only function if there is enough 
disk space to create and edit a backup file. If the required space is not 
available, a warning dialog and allow you to open the soundfile as a 
No Backup soundfile. 

Scroll After Play 
When the Scroll After Play command is checked, the waveform editing 
area of the soundfile window will automatically scroll to the playback 
stopping point when you let go of the mouse button in Scrub mode. 
This is a very helpful function for pinpointing specific spots in long 
soundfiles. This command is a simple toggle. 
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HDPlay Buffer Size ... 
The HDPlay Buffer Size ... command is used to tell Sound Designer II 
what size playback memory buffer you wish to use when playing back 
directly from the hard disk. 

Generally speaking, a setting of 8 will function with the best results. 
However, if you are running Sound Designer II under MultiFinder, 
you may receive a warning that it is impossible to allocate a buffer that 
is large enough. If this happens, increase Sound Designer 11' s memory 
size by selecting the program's icon on the desktop, and using the 
Finder's Get Info ... command. 

NITTE: If you are playing back from a slow or very fragmented hard 
disk, or you experience hesitations during hard disk playback, increase 
the HDPlay buffer size until the problems desist. Optical drives 
usually require a setting of 32. 

RAM Buffer 
The RAM Buffer command allocates the amount of memory Sound 
Designer II can access instantaneously for playback and record opera­
tions. 

Preferences .. . 
The Preferences ... command allows you to assign the default setting for 
various Sound Designer II parameters. These settings are saved with 
the Sound Designer II application upon quitting and are restored the 
next time the application is opened. When you choose this command, 
the following dialog box appears: 
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User Default Options 

D Ruto-name regions Uertical Scales: I ~ Sc11le 
D Ruto-n11me pl11ylists ..--Ti-im_e _____ ___,, 

Horiz. Scales: _I --------

0 Pre-allocate HD buffers: Multiple • Li 
Default Cross fade: [D IO I msec 

Preulew edit pre-roll: 13 I sec 

Preulew edit post-roll: 13 I sec 

( OK 

The Preferences dialog 

Clicking on Auto-name regions automatically names regions "Region 1 ", 
" Region 2", and so on when created. (Regions can be renamed later by 
using the Rename Region ... command in the Playlist menu). 

Clicking on Auto-name Playlists automatically names Playlists ''Playlist 
1", "Playlist 2", and so on when captured. (Playlists can be renamed 
later by using the Rename Playlist ... command in the Playlist menu). 

Clicking on Pre-allocate hard disk buffers makes hard disk playback more 
instantaneous by setting aside areas of available RAM for this function. 
This option is especially useful for reducing the lag that sometimes 
precedes hard disk playback when multiple files are open. However, 
you must restart Sound Designer II after selecting this for it to take 
effect. 

Clicking on Preview edit pre-roll allows you to set the default pre-roll 
time for the Edit Regions and Preview Edit commands in the Playlist 
menu. 
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Clicking on Preview edit post-roll allows you to set the default post-roll 
time for the Edit Regions and Preview Edit commands in the Playlist 
menu. These defaults will also affect playback from the overview if the 
Option or Command keys are pressed while clicking the speaker icon. 

Default crossfade sets the default crossfade type for new Playlist regions 
that are dragged into the Playlist. 

Vertical Scales sets the default units displayed in the vertical axis of 
new soundfiles. 

Horizontal Scales sets the default units displayed in the horizontal axis 
of new soundfiles. 

SMPTE Offset ... 
The SMPTE Offset ... command is used to set an-offset relative to 
incoming SMPTE time code. See Chapter G for details. 

Set Current Time ... 
The Set Current Time ... command is used to select your SMPTE, Feet 
and Frames, or Bars and Beats format. The format you choose here 
dictates the form of each of these units when they are displayed as axis 
marks, or used for duration or synchronization units. This command is 
only active when the insertion point is blinking in your soundfile. 

The Capture button provides a convenient way to enter a specific 
SMPTE value from an incoming time code signal with a mouse click. 
For specific information about SMPTE format, see the Appendix of this 
manual. Before you can really use Bar and Beat information, you 
should define your time units using the Set Interval... command. 

You will also use the Set Current Time ... command to set the absolute 
position of the current insertion point in your format of choice. All 
other time positions will then be displayed relative to that absolute 
position. 
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Set Interval ... 
The Set Interval ... command is used to tell Sound Designer II what type 
of musical interval is represented by the selected range. It is only active 
when the insertion point is blinking in your soundfile. To view your 
soundfile in bars and beats, select a waveform range which 
corresponds to a sixteenth note, eighth note, quarter note, half note, or 
whole number of bars, and choose the Set Interval ... command on the 
Setup menu. Oick on the button in front of the unit that is represented 
by the currently selected waveform range, then click on the OK button. 

NOTE: Bar and beat information will only be of use on sequenced and 
other time-locked material. Any soundfile that does not maintain near­
perfect timing throughout its duration will fall out of sync with the bar 
and beats mark. 

Set Colors ... 
The Set Colors ... command to assign different colors or gray levels to 
the major components of Sound Designer II' s soundfile windows. (This 
command remains dimmed unless you have a Macintosh that is 
capable of color or gray scale display, and which has the Color docu­
ment in the System folder.) Oick on a display component (overview, 
waveform, sound cursor, scale marks, etc.). This opens the Color 
Picker, which you can use to select a color or gray level for the selected 
Sound Designer II component. The color settings dialog will reappear 
with the newly colored component. Repeat this procedure until all 
colors are to your liking. 

NOfE: The color settings are used for all soundfiles, and cannot be set 
differently for different files. 

Sampler ... 
The Sampler ... command is used to configure Sound Designer II so that 
it can communicate with your samplers. See Chapter F for more 
information about working with samplers. 
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Appendix 

Basic Sampling Concepts 

Sound Designer II accomplishes its direct-to-disk recording tasks using 
a method called sampling. Unlike normal magnetic tape recording, 
which records an audio signal as a continuous charge on magnetic 
tape, a sampler converts an audio signal to discrete numbers which are 
then stored on a digital storage medium (a hard disk, for example). 

Digital sampling of audio tracks is generally superior to standard 
analog recording methodS-not only because it offers extremely high 
fidelity, but because it avoids the standard tape generation and "play­
back degradation" problems. Because sampled audio is stored as a set 
of numbers, there is no loss of fidelity when you copy those numbers, 
regardless of how many 1copies of copies' you make. Also, because the 
disk medium is not physically strained by playback (as is a reel of 
analog tape when it is pulled across the playback heads), repeated 
playback of a digital track will not alter or degrade that track in any 
way. For these reasons (among others), digital recording of audio 
tracks has become the method of preference for many contemporary 
producers. 

The process of digital recording (or sampling) is really quite simple: 
An audio signal is fed into a computer (or dedicated sampling device) . 
That signal is run through an analog-to-digital converter (ADC), which 
measures the amplitude (volume) of the signal at regular intervals and 
passes these measurements or 1samples' on to a storage medium. 
When the recorded track or tracks need to be played back, the samples 
are retrieved from the storage medium and run through a digital-to-
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analog converter (DAC), which converts those samples back into a 
continuous wave. The signal that comes out of the DAC is the output 
signal, and it is a nearly exact image of the signal that was fed into the 
ADC. Here is a diagram illustrating the way in which samples of an 
incoming audio signal are taken: 

Taking Samples of a Sound Wave 

Time_____. 

Sampling a sound wave 

As you can see, the incoming audio waveform is approximated by a 
series of discrete points that describe that waveform. This illustrates 
one of central questions of digital :recording: How accurate is the 
digital representation of the original analog signal? To determine this 
you will need to understand the concept of sample rate. 

Sample rate is the number of samples of a waveform that you take in a 
single second, and it has a very strong influence upon the quality of 
the recording you make. At best, a collection of samples is an ex­
tremely good approximation of the original input signal. By taking 
many samples of an audio signal, you end up with a more accurate 
depiction of the wave -fewer samples yield a less accurate, 'grainy' 
depiction. Here's an illustration: 
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Why Sample Rate Affects Fidelity 

I 
Time---+ Tune--+ 

Higher Sample Rate Lower Sample Rate 

How different sample rates affect fidelity 

Notice how a higher sample rate yields a more accurate, and therefore 
higher-fidelity recording. Unfortunately each sample requires storage 
space. Since a higher sample rate is taking more samples per second, it 
will require more disk storage space for each second of audio than a 
lower rate. Sound Designer II uses base sample rates of sample rate of 
44,100 Hz and 48,000 Hz, which means it takes 44,100 (or 48,000) 
samples every second and puts them on your hard disk. 44, 100 Hz is 
the same rate used on audio compact discs, and it allows you to record 
frequencies up to 22,050 Hz. 48,000 Hz is available on most digital 
audio tape (DAT) recorders, and it allows you to record frequencies up 
to 24000 Hz. Since normal human hearing ranges approximately from 
20 Hz to 20,000 Hz (or less), the fixed sample rate of 44.1 kHz generally 
offers more than enough fidelity. 
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About Time Code and Synchronization 

SMPTE (Society of Motion Picture and Television Engineers) time code 
is a running "clock" in the form of a digital data stream that can be 
recorded on magnetic tape as an audio signal. SMPTE time code can 
be used to synchronize the playback and recording of your Sound 
Tools II system with another audio system, such as an analog multi­
track tape machine or a video tape recorder (VTR). 

SMPTE time is based on hours, minutes, seconds and frames. Depend­
ing on the SMPTE format (covered in the next section), one frame is 
equal to 1/24th, 1/25th, or 1/30th of a second. The frame unit is used 
as a unit of time measurement due to SMPTE time code's origin in film 
and video applications. 

Because SMPTE stores 24-30 exact time stamps per second on the tape, 
any location on that tape can be precisely located by devices that read 
time code. Once the time code has been recorded or "striped" on a 
tape, it provides a permanent time reference that allows Sound De­
signer II to link the playback of an event to an exact tape location. 
Thanks to SMPTE synchronization, a gunshot sound effect can be 
played at the precise instant that the gun's flash appears on-screen, and 
soon. 

There are two basic techniques used to record SMPTE time code on 
magnetic tape: Longitudinal Time Code (LTC) and Vertical Time 
code (VITC). 

LTC is recorded as an audio signal on one of the audio tracks on the 
audio or video tape. VITC is recorded within the video signal-each 
SMPTE "message" is recorded between the video frames. VITC cannot 
be recorded on audio tracks, so it's not useful for recording audio-only 
tape machines, but it does offer powerful features for video professionals. 
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Each type of SMPTE has its own set of pro and cons: 

LTC can be read at high tape shuttle speeds, allowing professional 
time code readers to stay "in sync" at rewind or fast forward speeds 
exceeding 50 times playback speed (provided the tape recorder is able 
to reproduce the time code at this speed). Unfortunately, LTC cannot 
be read at very slow shuttle speeds (such as when you are "crawling" 
the tape frame by frame) or in pause. Sound effects editors often 
shuttle the tape frame by frame to locate the exact point at which the 
sound effect should occur. With LTC, the VTR must be running 
(usually at a minimum speed of about 1/lOth normal playback speed) 
in order to capture a SMPTE time. 

When VITC is used, Sound Designer II can capture the current SMPTE 
time from the VTR when it's paused or in "crawl" mode. However, 
most synchronizers cannot read VITC at speeds exceeding about 10 
times playback speed, preventing slaved machines from maintaining 
synchronization during rewind and fast forward. 

Because VITC cannot be recorded on audio tracks, it's never used to 
synchronize audio-only recorders. As a result, LTC is more commonly 
used in audio-only applications. VITC's strength at slow speeds makes 
it much more useful in audio-for-video environments. 

SMPTE Formats 

Five different formats of SMPTE time code exist: 30 frame nondrop, 
29.97 frame nondrop, 30 drop-frame, 25 frame nondrop (EBU) and 24 
frame nondrop. 

The 30 frame nondrop format is based on a frame rate of 30 frames per 
second. This is the original SMPTE format developed for monochrome 
(black and white) video. 
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The 30 drop-frame format was developed for use with color video, 
which has an actual frame rate of 29.97 frames per second. This slight 
deviation from the standard 30 frames/ second rate causes synchroni­
zation inaccuracies to accumulate, resulting in ever-increasing time 
offset the longer a source plays. To compensate for this discrepancy in 
frame rates, the first two frames of each minute are "dropped" (omit­
ted) with the exception of every 10th minute. This results in 108 
frames being dropped every each hour, exactly the number required to 
avoid accumulation error (and reflect true 'wall dock' in the time code 
clock values). 

The 29.97 frame nondrop format is also used with color video to 
achieve the proper frame rate by slowing the overall frame rate instead 
of dropping frames. It's important to note that "one hour" of 29.97 
frame nondrop time code is actually one hour and 3.6 seconds of "real 
time" due to the fact that the slower frame rate does not match 'wall dock.' 

The 25 frame nondrop (EBU) format is very similar to the 30 frame 
nondrop format, but is based on a frame rate of 25 frames/ second. 
This format is also called the EBU (European Broadcast Union) format 
because it's used by broadcasters throughout Europe (where alternat­
ing current rates are 50 cycles/second instead of 60 cycles/second). 

The 24 frame nondrop format is used exclusively for film applications. 
Film is often photographed and projected at a rate of 24 frames per 
second, so this SMPTE format is useful when one time code frame 
should equal one film frame. 
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The Need for Synchronization 

Synchronization is necessary for two reasons. First, it allows con­
nected systems to start and stop their transports together, without 
requiring an operator to run all the transports individually. Secondly, 
it keeps the systems in lock-step while their transports are running, so 
that no individual system gets ahead of, or behind any other system. 

Without synchronization, the operator would have to start and stop 
each individual transport manually at precisely the same time. Even if 
this were possible, once the transports began running, they would all 
run at slightly different rates. Analog tape transports, being mechani­
cal, have small fluctuations in tape speed called "wow and flutter". 
The capstans on tape machines can slip over time as well, also generat­
ing changes in tape speed. 

With disk-based systems such as Sound Tools II, there is no mechani­
cal transport and no tape. Instead, the playback and record speeds are 
controlled by quartz crystal oscillators. However, no two oscillators 
are exactly the same, and an oscillator's frequency can vary with time 
and temperature. What all this means is that any two transports, even 
when started at exactly the same time, will begin to drift apart over time 
and the audio on the different systems will eventually drift out of sync. 

Synchronization is achieved in these systems by constantly checking to 
see the current SMPTE frame, and adjusting the playback speed to 
keep all devices locked. In analog systems, this is achieved by auto­
mated motor speed control. In digital systems it is achieved by 
adjusting the playback sample rate. 
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Sound Tools II and SMPTE 

Sound Tools II supports two types of SMPfE synchronization to deal 
with the above problems. The first type is called SMPTE Trigger, and 
it allows Sound Designer II to chase and start (or stop) playback and 
recording while slaved to other systems. However, in a trigger envi­
ronment, once playback or recording starts there is no further synchro­
nization, and Sound Designer II will play back at a rate determined by 
the Audio Interface's crystal oscillator. 

The second type of synchronization is called Continuous SMPTE 
Resynchronization. It is virtually the same as SMPTE Trigger, how­
ever, once playback or recording commences, the playback or record­
ing speed of the Sound Tools II system is continuously adjusted to 
match and lock to the incoming SMPTE time code. 

NOTE: Remember, as you see in the analog world, constant variation 
of playback and record speeds can degrade overall audio fidelity. It is 
always wise to use a time code source that is as solid and accurate as 
possible. 

Choosing a Synchronization Method 

Each type of synchronization has its own important advantages and 
disadvantages. The one you choose will depend on your unique 
situation. For short audio pieces (30 seconds or less), SMPTE trigger is 
sometimes preferable, especially if the sync master has a fairly stable 
transport. In this case, the two transports will probably not drift very 
far apart in such a short period of time, so Continuous SMPTE Resync 
is unnecessary. On the other hand, if the audio piece is several min­
utes long, or if the sync master has an unstable transport (as in the 
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case of a cassette player sbiped with SMPTE, for example), Continuous 
SMPTE Resynchronization will be necessary in order to prevent the 
two systems from drifting apart noticeably over the duration of the 
piece. 

There is another important difference between the two types of syn­
chronization: When you use continuous SMPTE resync, the audio 
quality of the Sound Tools II system can be affected by variations in 
the incoming SMPTE Time Code. In order for the Sound Tools II 
system to stay synchronized to the incoming SMPTE, it must slow 
down and speed up the digital audio to match the changes in speed 
the SMPTE Time Code makes. This is accomplished by varying the 
sample rate of the Sound Tools II system in real time using the Sound 
Tools II Digital Signal Processors (DSPs). The net result is that any 
"wow and flutter" in the original SMPTE source is "copied" into the 
digital audio. 

Depending on the stability of the original source of the SMPTE Time 
Code, this variation in sample rate can cause results that range from 
unnoticeable to unacceptable. The same problem would exist if you 
substituted an analog tape machine for the Sound Tools II system;: its 
synchronizer would cause it to slow down and speed up (warble) to 
match the fluctuations in the incoming SMPTE Time Code as well. 

A third, better alternative exists. This technique uses SMPTE Trigger, 
but maintains long-term synchronization by using the Video Slave 
Driver™, available separately from Digidesign. 

The Video Slave Driver is a peripheral device for Sound Tools II that 
allows you to calibrate Sound Tools II's recording and playback clock 
to an external video black burst or word clock signal. The Video slave 
Driver accepts either of these signals and then converts it into a master 
clock signal which it sends to the Sound Tools II Audio Interface. By 
sending the same master black burst clock signal to Sound Tools II and 
your video deck, all elements of your system will run at exactly the 
same speed, thereby staying in sync. 
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In this case, SMPTE Time Code is only used to locate, chase, and 
trigger; as explained above, playback speed of both Sound Tools II and 
the video tape recorder are then controlled by the blackburst or word 
clock signal. This technique will produce better audio quality than 
continuous SMPTE resync (on fluctuating sync signals), and it guaran­
tees that the Sound Tools II system will remain tightly locked to the 
sync source. 

Using SMPTE 

The basic idea behind a SMPTE-synchronized network of devices is 
that each device (analog tape machine, video tape machine, Sound 
Tools II system, etc.) is initially "striped" with SMPTE before anything 
else is recorded. One of the devices is assigned to be the "master" and 
all other devices read and follow the SMPTE time code read from the 
master. They follow (or synchronize to) the master device by compar­
ing their own SMPTE time code "stripes" to the incoming code from 
the master device, and continually adjust their own transport speed so 
that all devices are registering the exact same SMPTE time code value 
at the same time. 

In such a system, if the master device begins to slow down, all other 
devices will slow down right along with it, matching the master's 
speed variations so that all devices are playing back at the same speed. 
Even after many minutes, they will still be locked to each other, 
because the current master SMPTE time is mirrored by all slave 
devices. 

To set up such a system, you must first stripe each medium (video 
tape, audio tape, etc.) with SMPTE time code. On analog tape ma­
chines, this means recording longitudinal SMPTE time code (L TC) on 
one of the tracks of the audio tape. On video tape machines, you can 
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either record LTC on one of the audio tracks on the video tape, or you 
can record Vertical Interval SMPTE time code (VITC) in the vertical 
retrace interval of the video signal itself. 

If you expect to send any of your SMPTE-striped material to someone 
else, or especially if you intend to provide it to professional broadcast­
ing, you must make sure that the SMPTE time code that your generator 
is producing is very accurate. This is accomplished by resolving (or 
synchronizing) the actual SMPTE time code generator itself to a very 
accurate clock signal, such as house sync or black burst. The tape 
machine you are striping should also have its transport resolved to the 
same clock signal. This is the only way to guarantee that the SMPTE 
time code on tape is within the tight timing tolerances that professional 
broadcasting requires. 

If you do not resolve your generator, or if your generator is incapable 
of being resolved (most low-cost SMPTE generators cannot be re­
solved), then you should not expect a professional broadcaster to 
obtain accurate results from the tapes you produce. If you only use 
SMPTE within your own work environment, and especially if you do 
not use it in context with video, then an unresolved generator provides 
less of a problem. However, the most flexible choice is to buy the best 
resolvable generator (and black burst source, if needed) that you can 
afford, since this generator really provides the heartbeat of your entire 
SMPTE system. 

Because Sound Tools II is a completely digital system, you do not need 
to stripe any track with SMPTE. Sound Designer II use the Sound 
Tools II digital sample clock to generate and read very accurate time 
code. You only need to specify the SMPTE time at which you want the 
any region to start, and Sound Designer II can translate SMPTE times 
to digital sample numbers "on the fly". 

Any slave devices in the system other than Sound Tools II will require 
their own synchronizer in order to follow the master SMPTE time 
code. The master device itself does not need a synchronizer, since it is 
generating rather than reading. 
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Sound Designer II synchronizes to SMPI'E time code by reading the 
MIDI Time Code (MTC) that is generated from the master's SMPTE. 
MIDI time code is the computer's version of SMPTE time code. MTC is 
created by a SMPTE-to-MIDI time code converter, such as Opcode 
Systems' Studio 3, or Mark of the Unicorn's MIDI TimePiece. These 
converters take 1I4 inch analog SMPTE signal and convert it to the 
digital version of that code that is fed into your computer's serial 
(modem or printer) port. 

Note that the SMPTE time code formats striped on all devices must 
match. Different devices should not have different frame rates. For 
exact instructions concerning SMPTE setup and spotting audio, see 
Chapter G of the Sound Designer II manual . 

Recommended Hard Disks 

Because of the great variety of hard disks currently available, it is not 
possible here to give a comprehensive list of drives that are recom­
mended or not recommended. Your best bet is to obtain a hard drive 
that meets the following specifications: an average access time of 27 
ms or faster, and a throughput of 400 Kbytes per second or higher. 

NOfE: Individual manufacturers are not always the best source for 
speed information about their drives. Digidesign has encountered 
many instances where actual hard drive access and throughput varied 
considerably from the manufacturer's specification sheet. To be sure 
that you are getting a capable hard drive, consult your dealer or 
consider Digidesign's Pro Store series of hard drives which meet the 
above requirements. 
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Backup and Archiving Suggestions 

Recording audio to your hard disk will use a considerable amount of 
disk space-approximately 20 megabytes per minute of linear four 
track audio. For this reason it is a good idea to have some type of 
archiving medium for keeping master and backup copies of your 
recordings. Here are some devices that are very useful for archiving 
purposes: 

Erasable Optical Drives. These drives store 600 megabytes (or more) 
on a single removable cartridge (300 megabytes per side). Since the 
medium is magneto-optical (a combination of magnetics and laser 
technology), the cartridges have few moving parts and a relatively 
long storage life. Unfortunately they are not yet fast enough for four 
track recording, and are only useful as an archiving medium. 
Digidesign's Pro Store™ Magneto Optical hard drive provides a 
reliable option for recording stereo audio files or archiving multitrack 
audio files on removable·optical media. 

Removable Platter Drives. These drives store 44 or 88 megabytes on a 
removable magnetic platter cartridge. Although most implementations 
of the mechanism are fast enough for four track recording and play­
back, some are not. Generally speaking, 44 and 88 megabyte removable 
drives are of limited use as a recording or archiving medium, because 
they hold only about 2 or 4 minutes (respectively) of total source audio 
at full fidelity. 

WORM Drives. WORM drives can record data once. They are ex­
tremely high-capacity (900 megabytes or more), but they cannot be 
erased or rewritten. They have a very long storage life, and are useful 
as a long-lasting master archive. They are not fast enough for four 
track recording or playback. 

Streaming Tape Drives. Streaming tape drives are generally the least 
expensive data backup devices, and because they use verification 
schemes, they guarantee file integrity. They store data on magnetic 
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cassettes (DAT or otherwise) in sequential fashion, so they tend to be 
very slow, but the media costs are minimal. Because the storage 
medium is magnetic, the storage life may be limited - but no more so 
than traditional magnetic audio tape. In many ways, the combination 
of a large, fast hard disk for recording and mastering, and a DAT 
backup drive (a WangDAT drive, for example) for archiving may be 
the best price-for-performance combination. 

DAT Recording Decks. While digital audio recording decks are a 
reasonable and cost- effective archiving alternative for your Session 
audio files, they do have some drawbacks. One favorable fact is that 
any audio backed up digitally to a DAT recorder can be played back 
two tracks at a time and auditioned as normal audio. 

However, remember that they use error-correction schemes, so you 
may encounter generation loss in your digital audio. Generally speak­
ing, digital mixing/transfer to standard DAT recorders is best reserved 
for use as a client (or mastering) delivery medium. 

Digidesign's DATa™ software. If you are cost-conscious, you will 
find our DATa™ software a good option. This allows you to back up 
your audio files and edit information onto a standard audio DAT 
cassette, using your DAT recorder. 

Because you are using an audio DAT recorder, the transfer will take 
place in real-time, and the DAT recorder will not alert you to any 
errors in transmission. You will need to listen to the entire tape to 
ensure that the files were transferred properly. However, it is still a 
convenient and affordable way to back up files. DATa is sent free of 
charge to all regi.stered Sound Tools users. (That's just one more good 
reason to send in your Sound Tools registration card. Don't delay!) 

The backup method you choose should be weighed on how much you 
are willing to spend, versus how much time you want to devote to 
saving and restoring files. If you have more questions about Mac-compat­
ible storage systems, we recommend that you check back issues of 
Mac User and Mac World magazines for in-depth reviews and comparisons. 
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Calibrating Your Audio Interface 

After you have become familiar with your Sound Tools II package, you 
will want to calibrate it to the rest of your system. 

Calibrating or "aligning" digital audio systems is somewhat different 
from aligning analog tape recorders. Unlike analog tape recorders, 
most digital audio recorders do not have a .standard "O VU" level 
setting that corresponds to nominal input and output levels. Instead, 
the Audio Interface's meters are calibrated in decibels below peak 
(clipping) level. Whereas analog tape recorders clip fairly gracefully, 
allowing for a certain amount of headroom above the 0 VU level, 
digital recorders sound terrible as soon as they reach clipping. As a 
result, it is important to calibrate the Audio Interface so that nominal 
(or "O VU") level in your system corresponds to a level well below 
peak or "O" level on the Audio Interface's meters. 

There is no industry standard setting for nominal level in a digital 
audio system. We recommend that you allow 10 to 20 dB of headroom 
above nominal level-the exact value you use will be determined by 
the amount of headroom available in the rest of your system. (If your 
mixing console has 15 dB of headroom above nominal level, for 
example, then you should calibrate the Audio Interface to have 15 dB 
of headroom). 

In the following alignment procedure, we will use 15 dB as our se­
lected headroom amount. 

Before proceeding, the Audio Interface must be connected to a Sound 
Accelerator II installed in a Macintosh running Sound Designer II. 

• Connect a 1 kHz sine wave (from a sine wave generator) at 
nominal level ("O VU") to the Audio Interface's inputs. 

• Adjust the Audio Interface's front-panel channel 1 input level 
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trim pot by inserting an 1 /8-inch screwdriver into the Input 
Level Trim pot and turning to the right until the correspond­
ing segment of the Sound Designer II record meter is lit. 

• Repeat this process for channel 2. 

• Next, record about 30 seconds of the sine wave (see the Chap­
ter E for more information on recording). Oick on the Return to 
Zero button when you are done recording. 

• Be sure that the Audio Interface's outputs are properly con­
nected to the mixing console' s "tape return" or line inputs, and 
the console is set to meter the incoming tape return or line 
level. 

• Click on Sound Designer II' s Play button to play the test signal 
you just recorded. 

•Adjust the Audio Interface's front panel channel 1 Output 
Level trim pot by inserting the screwdriver into the Output 
Level trim pot and turning to the right until the console' s tape 
return (or line in) meter reads "O VU". 

• Repeat this process for channel 2. 

You may want to check the calibration of the Audio Interface at 
different frequencies (i.e. 100 Hz and 10 kHz) following the same 
procedure as above. However, this should not be necessary since the 
Audio Interface is a digital device with very flat frequency response. 
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CS-1 Implementation for Sound Designer II 

The CS-1 and CS-10 control surfaces from JL Cooper Electronics offer an alternative to 
controlling Sound Designer II with a Mouse. By providing faders, a jog wheel and 
function keys, JL Cooper offers you familiar and responsive control for your Sound 
Tools system with exceptional speed and flexibility. 

Here, briefly, are descriptions of how the CS-1 controls are implemented in Sound 
Designer II: 

Left Diamond: 
Same as left zoom arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

SHIFT-Left Diamond: 
Same as left horizontal scroll arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

Right Diamond: 
Same as right zoom arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

SHIFT-Right Diamond: 
Same as right horizontal scroll arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

Up Diamond: 
Same as up zoom arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 

SHIFf-Up Diamond: 
Same as up vertical scroll arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 
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Down Diamond: 
Same as down zoom arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

SHIFT-Down Diamond: 

Play: 

Same as down vertical scroll arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

If the transport is currently in Stop mode, SDII will enter Play 
mode. 

Equivalent to hitting the SPACE BAR. Works in both Waveform 
Window and Play list Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

SHIFT-Play: 
Equivalent to hitting the SPEAKER icon in the Waveform 

Window. 
Equivalent to Preview Edit in the Playlist Window. 
Equivalent to hitting the SPEAKER icon in the Edit Fades dialog. 
Equivalent to hitting a SPEAKER icon in the Edit Regions dialog. 

Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor backwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist backwards in time. 

SHIFT-Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the window to the start of the soundfile. 
In the Play list Window, stops any current playback and scrolls 

the playlist to the first region in the playlist. 
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Fast Forward: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor forwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist forwards in time. 

SHIFT-Fast Forward: 

Stop: 

In the Waveform Window, stops any current playback and 
scrolls the window to the end of the soundfile. 

In the Playlist Window, stops any current playback and scrolls 
the playlist to the last region in the playlist. 

If the transport is currently in Play mode, SDII will enter Stop 
mode. 

Equivalent to hitting the SPACE BAR. Works in both Waveform 
Window and Playlist Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

Record: 
In the Record Dialog, if On-Line, it puts the transport into 

Record-Ready mode. If not On-Line, it puts the transport into 
Record-Play mode and immediately begins recording. 

Equivalent to hitting the RECORD button. 

F1 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection start, or insertion point if there is no selection, is 
placed at the current play position. 

In the Waveform Window, if transport is in Stop Mode, the 
selection start, or insertion point if there is no selection, is 
placed at the point last scrubbed to, and then the window is 
scrolled to that point. 
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SHIFT-F1 Button: 
In the Waveform Window, it drops a marker at the current 

playback position. 
Equivalent to hitting the ENTER key. 

F2 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection end is placed at the current play position. 
In the Waveform Window, if transport is in Stop Mode, the 

selection end is placed at the point last scrubbed to, and then 
the window is scrolled to that point. 

SHIFT-F2 Button: 
In the Waveform Window, it puts the wheel in Scroll Mode. 

F3 Button: 
In the Waveform Window, it will execute the Capture Region 

menu command if a selection exists in the waveform. 

SHIFT-F3 Button: 
In the Waveform Window, it puts the wheel in Jog Mode. 

F4 Button: 
If in the Waveform Window, switches to the Playlist Window. 
If in the Playlist Window, switches to the Record dialog. 
If in the Record dialog, switches to the Waveform Window. 
If in the Edit Fades dialog, switches to the Playlist Window. 
If in the Edit Regions dialog, switches to the Playlist Window. 

SHIFT-F4 Button~ 
In the Waveform Window, it puts the wheel in Shuttle Mode. 

On-Line Button: 
The on-line mode is inverted, from ON to OFF, or from OFF to ON. 
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Wheel: 
Begins scrubbing in Waveform Window if in scrub mode. 
Begins jogging in Waveform Window if in jog mode. 
Scrolls thru the soundfile in Waveform Window if in scroll 

mode. 
Scrolls thru the list of regions if in the Playlist Window. 

CS-10 Implementation for Sound Designer II 

Here, briefly, are descriptions of how JL Cooper's CS-10 controls are implemented in 
Sound Designer II: 

Left Diamond: 
Same as left zoom arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

SHIFT-Left Diamond: 
Same as left horizontal scroll arrow in Waveform Window. 
Same as left zoom arrow in Loop Window. 

Right Diamond: 
Same as right zoom arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

SHIFT-Right Diamond: 
Same as right horizontal scroll arrow in Waveform Window. 
Same as right zoom arrow in Loop Window. 

Up Diamond: 
Same as up zoom arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 
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SHIFT-Up Diamond: 
Same as up vertical scroll arrow in Waveform Window. 
Same as up zoom arrow in Loop Window. 

Down Diamond: 
Same as down zoom arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

SHIFT-Down Diamond: 

Play: 

Same as down vertical scroll arrow in Waveform Window. 
Same as down zoom arrow in Loop Window. 

If the transport is currently in Stop mode, SDII will enter Play 
mode. 

Equivalent to hitting the SP ACE BAR. Works in both Waveform 
Window and Play list Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

SHIFT-Play: 
Equivalent to hitting the SPEAKER icon in the Waveform 

Window. 
Equivalent to Preview Edit in the Playlist Window. 
Equivalent to hitting the SPEAKER icon in the Edit Fades dialog. 
Equivalent to hitting a SPEAKER icon in the Edit Regions dialog. 

Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor backwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist backwards in time. 

SHIFT-Rewind: 
In the Waveform Window, stops any current playback and 

scrolls the window to the start of the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the playlist to the first region in the playlist. 
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Fast Forward: 
In the Waveform Window, stops any current playback and 

scrolls the play cursor forwards through the soundfile. 
In the Playlist Window, stops any current playback and scrolls 

the current region in the playlist forwards in time. 

SHIFT-Fast Forward: 

Stop: 

In the Waveform Window, stops any current playback and 
scrolls the window to the end of the soundfile. 

In the Playlist Window, stops any current playback and scrolls 
the playlist to the last region in the playlist. 

If the transport is currently in Play mode, SDII will enter Stop 
mode. 

Equivalent to hitting the SPACE BAR. Works in both Waveform 
Window and Play list Window. 

Equivalent to hitting the SPEAKER icon in the Loop Window. 

Record: 
In the Record Dialog, if On-Line, it puts the transport into 

Record-Ready mode. If not On-Line, it puts the transport into 
Record-Play mode and immediately begins recording. Equiva­
lent to hitting the RECORD button. 

F1 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection start, or insertion point if there is no selection, is 
placed at the current play position. 

In the Waveform Window, if transport is in Stop Mode, the 
selection start, or insertion point if there is no selection, is 
placed at the point last scrubbed to, and then the window is 
scrolled to that point. 
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SHIFT-F1 Button: 
In the Waveform Window, it drops a marker at the current 

playback position. 
Equivalent to hitting the ENTER key. 

F2 Button: 
In the Waveform Window, if transport is in Play Mode, the 

selection end is placed at the current play position. 
In the Waveform Window, if transport is in Stop Mode, the 

selection end is placed at the point last scrubbed to, and then 
the window is scrolled to that point. 

SHIFT-F2 Button: 
In the Waveform Window, it puts the wheel in Scroll Mode. 

F3 Button: 
In the Waveform Window, it will execute the Capture Region 

menu command if a selection exists in the waveform. 

SHIFT-F3 Button: 
In the Waveform Window, it puts the wheel in Jog Mode. 

F4 Button: 
If in the Waveform Window, switches to the Playlist Window. 
If in the Playlist Window, switches to the Record dialog. 
If in the Record dialog, switches to the Waveform Window. 
If in the Edit Fades dialog, switches to the Playlist Window. 
If in the Edit Regions dialog, switches to the Playlist Window. 

SHIFT-F4 Button: 
In the Waveform Window, it puts the wheel in Shuttle Mode. 

F9 Button: 
The on-line mode is inverted, from ON to OFF, or from OFF to ON. 
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Wheel: 
In the Waveform Window, it puts the wheel in Shuttle Mode. 
Begins scrubbing in Waveform Window if in scrub mode. 
Begins jogging in Waveform Window if in jog mode. 
Scrolls thru the soundfile in Waveform Window if in scroll mode. 
Scrolls thru the list of regions if in the Playlist Window. 

Digital Sampler Personalities 

The digital samplers offered by various manufacturers each have their 
own personality traits. This section provides information that will be 
helpful in communicating with the samplers supported by Sound 
Designer II. 

Akai S900/S950 
The Akai 5900 and 5950 are twelve bit samplers with maximum 
sampling times from 11.75 seconds to 63.3 seconds depending on the 
sample rate used. They have a variable sample rate ranging from 7.5 
kHz to 40 kHz. 

The 5900 and 5950 require the loop end point to be placed at the end of 
a sample. If you transfer a sound file to the 5900/950 that contains 
sound data after the loop end point, the sound file be automatically 
truncated at the loop end point. 

Akai S700 and X7000 
The Akai 5700 and X7000 are very similar. In fact, the MIDI messages 
used to transfer samples to and from these samplers are identical. In 
the remainder of this description, "S700" will refer to both 5700 and 
X7000 samplers. 
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The S700 is a 12-bit sampler with 6 sample locations. With a memory 
expansion board the S700 can store up to 16 samples. Each sample 
location can hold 32752 samples of data. 

The S700 has a variable sample rate. 26400 is the most commonly used 
sample rate. 

The S700 does not support sound names, only numbers are used to 
differentiate one sound from another. 

When a sound transfer replaces a sound in the S700 with a larger 
Macintosh sound file, the sound file may not need to be truncated. This 
due to the 32752 samples of memory that are always allocated for a 
sample location. 

Truncation is only based upon whether the sound file is larger than 
32752 samples or not. 

The S700 only supports release loops (i.e. loops that continue after a 
key has been released). Therefore, sound files with sustain loops will 
be transferred to the S700 with release loops. 

Akai 81000 
The Akai S1000 is a 16-bit stereo sampler with a maximum sample rate 
of 44.1 kHz. Sound Designer can transfer sound data to the S1000 via 
both SCSI (optional SlOOO SCSI kit required) and MIDI. SCSI transfers 
are much faster than MIDI transfers. 

To send and receive samples via MIDI, connect both MIDI IN and 
OUT directly to your Mac MIDI interface and select the Sample Dump 
Standard (16-bit) setting in the Sampler dialog. Be sure to configure the 
SlOOO to send and receive on MIDI channel 1 or enable Omni mode. 

To send and receive samples via SCSI, the following conditions 
must be met 
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• With the Macintosh, external hard disk, all connected SCSI 
devices and the S1000 powered OFF, connect the S1000 to the 
Macintosh or any of the external SCSI devices with a certified 
SCSI cable. 

• Power on the S1000 and boot it with SCSI System software v 
1.3 or higher. 

•The S1000 SCSI Interface must be initialized each time the 
S1000 is powered on. If any files are loaded into the S1000 
from a hard disk, initialization is done automatically. Other­
wise, initialization must be completed manually. To manually 
initialize the S1000, press the S1000 function key DISK. At the 
LOAD FROM DISK prompt, tum the data knob until the value 
underneath the cursor changes to HARD. If the S1000 displays 
a message warning you that the hard disk is not ready, hit the 
softkey SKW. 

• Like all of the SCSI devices connected to the Macintosh, the 
S1000 must have a unique SCSI ID. On power up, the S1000 
defaults to an ID of 6. If you have any other device connected 
to the Macintosh with a SCSI ID of 6, you will need to change 
the SlOOO's SCSI ID. To change the ID, press the S1000 function 
key DISK. Press the softkey HDSK. Select an SCSI ID number 
that is not being used by any other device. Don't choose an ID 
of 7, which is reserved for the Macintosh. 

• Power on all the external SCSI devices first. Finally, tum on the 
Macintosh. Launch Sound Designer II and select Sampler from 
the Setup menu. 

• Select Add and choose 'Akai S1000 (SCSI)' from the sampler 
list. All further communications between the S1000 and 
Macintosh will occur via SCSI. 

NOTE: The S1000 cannot receive sound transfers when it is displaying 
waveforms. Be sure that the S1000 is NOT in the Edit Sample/Ed.1/Trim 
or Edit Sample/Ed.1/Loop pages when transferring sounds. 
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If the 51000 ever displays a SCSI error, a complete reboot of the system 
may be required to restore reliable communication. When powering 
down the system, reverse the above order. 

Casio FZ-1 and FZ-10M 
The FZ-1 and FZ-lOM are 16-bit samplers with 64 sound locations. 
With a memory expansion board they can store over 1,000,000 16 bit 
samples. 

The FZ-1 has three sample rates, 36 kHz, 18 kHz, and 9 kHz. 36 kHz is 
the most commonly used sample rate. 

In order to transfer sound data between the Macintosh and the FZ-1, 
the following conditions must be satisfied. 

Set MIDI basic channel to '01' 
Set MIDI receive to 'BASIC' 
Set select device to 'MIDI' 
Set the arrow mark to [REMOTE MODE] 

The FZ-1 does not send voice parameters such as sound names or 
lengths independently of sample data. Hence the transfer dialog is 
unable to display voice names or voice sizes while you are scrolling 
through sample locations. The user must determine which voice to get 
or replace from the front panel of the FZ-1. 

NOTE: If a MIDI communication problem occurs, the FZ-1 may 
display an error message. If the FZ-1 displays a message, you must 
press the Up cursor button. This action will clear the message and 
remove the FZ-1 from its error state. Until the error message is cleared, 
the FZ-1 will not communicate via MIDI. 

Sound Designer II 



E-mu Emax 
An RS-422 cable is required to use the Emax with Sound Designer II. 
Use the enclosed order form to order the RS-422 cable, or contact your 
local Digidesign dealer for cable price and availability. For reliable 
communications between the Emax and Mac, be sure to disconnect any 
MIDI devices from the Emax MIDI input. 

E-mu Emax II 
An RS-422 cable is required to use the Emax II 16 bit sampler with 
Sound Designer II. Always boot the Emax II with system software 
version 2.1.0 or higher. 

E-mu Emulator II 
Like the Emax, an RS-422 cable is required to use the Emulator II with 
Sound Designer II. Use the enclosed order form to order the RS-422 
cable, or contact your local Digidesign dealer for cable price and 
availability 

E-mu SP-1200 
The SP-1200 is a 12 bit sampler with 32 sound locations. It can store 
256K words of data. Memory is divided into 4 segments, each 64K in 
size. If you try to send a sound file large than 64K it will be truncated. 
When sending a sound to the SP-1200, you must replace an existing 
sound. You can not send a sound to a location that's 11Not Sampled." 
The SP-1200 has a single fixed sample rate of 26 kHz. The SP-1200 is 
not listed by name in the sampler menu - use the 12 bit MMA driver. 

Emulator Ill 
To use Sound Designer II with the SCSI interface on the EIII, you must 
have a Macintosh with an SCSI interface. Additionally, if your Mac 
does not include an SCSI hard disk, you must own an SCSI terminator. 
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NOTE: You must use a certified SCSI cable. The use of 'generic' ribbon 
cables is not recommended and can cause intermittent problems in 
communication between the EIII and the Mac. For best results, use EIII 
system software version 2.0 or higher. 

With the Eill, Macintos~ and all other connected SCSI peripherals 
turned off, daisy-chain the Elll to your Macintosh: 

•If your Mac setup does not include an internal SCSI hard drive 
nor any external peripherals, connect a SCSI terminator to the 
EIII, then use a SCSI cable to connect the terminator to the Mac 
SCSI port. 

•If your Mac setup includes an internal SCSI hard drive and no 
other SCSI peripherals, use a SCSI cable to connect the EIII to 
the Mac directly. 

• If you have an external SCSI hard drive or other SCSI peripher­
als, daisy-chain your SCSI drive and peripherals to the Mac. 
Without using a SCSI terminator, connect the EIII to the last 
SCSI peripheral. 

Once the connections have been finalized, you should use the 
following power-up sequence: 

• Tum on the EIII first and verify that its hard disk SCSI ID 
number is set to a value other than that of any other SCSI 
devices in the system, such as the Mac's hard disk. 

• Tum on any other SCSI peripherals. 

• Tum on the Macintosh. Once Sound Designer II has been 
launched, select Emulator III from the Sampler dialog. 

Sounds can now be transferred to and from the EIII by using the File 
menu transfer commands or the Mac -> Sampler icon. A dialog will 
indicate the status of the EIII's voices. If the EIII has no memory left for 
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the sample you wish to send it, the EIII Sample Deficit field (in the 
Mac->Sampler dialog) will indicate how much memory is required by 
the EIII. Samples cannot be truncated at or during the transfer, so EIII 
memory management by the user is important. When powering down 
the system be sure to reverse the above order. 

Ensoniq Miraga/Multisamplar 
For reliable communication between the Mirage and Macintosh, the 
Mirage must be booted with MASOS version 2.0 or higher (Ensoniq 
part #8500 0010 01). 

NOTE: When sending looped sounds to the Mirage, loop starts must 
be on a page boundary (starting on sample #0, pages are 256 samples 
long). 

Ensoniq EPSJEPS•m 
The Ensoniq EPS is a 13-bit sampler that can hold up to 8 instruments of 
up to 127 wavesamples each. The standard amount of memory is 512K 
bytes, or 1024 system blocks. The EPS has a wide range of sampling 
rates-from 6.25 kHz up to 52.1 kHz. Sound Designer II can transfer 
sounds to the EPS via SCSI or MIDI. 

In order to transfer sound data between the Mac and the EPS (using 
SCSI or MIDI), the following conditions must be satisfied: 

• You must use a startup disk with EPS OS 2.35 or higher. 

• MIDI Sys-Ex must be enabled on the EPS. From the EPS front 
panel, use the Edit-MIDI button sequence to tum MIDI SYS-EX 
on. Use Command-System to SAVE GLOBAL PARAMETERS if 
you want to make this a permanent change on your startup 
disk. 

• A system disk should be left in the EPS' s disk drive the first 
time a sound transfer is done so the EPS can read system 
information. 
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If you plan to use SCSI to transfer sounds between your Mac and EPS, 
please read the following instructions carefully. 

First, connect the EPS to the Macintosh using conventional MIDI 
connections: two MIDI cables-one for each direction-between the 
EPS and a Macintosh MIDI interface. 

Next, making sure the EPS, Macintosh, and all other SCSI peripherals 
in your setup are powered off, daisy-chain the EPS to your Macintosh 
setup using a standard Macintosh SCSI cable. 

If your Macintosh setup does not include an internal SCSI hard drive 
nor any external SCSI peripherals, connect an SCSI terminator to the 
EPS, then use an SCSI cable to connect the terminator to the Macintosh 
SCSI port. 

If your Macintosh setup includes an internal SCSI hard drive and no 
other SCSI peripherals, use a SCSI cable to connect the EPS to the 
Macintosh directly. 

If you have an external SCSI hard drive or other SCSI peripherals, 
daisy-chain your SCSI drive and peripherals to the Macintosh. Without 
using a SCSI terminator, connect the EPS to the last SCSI peripheral. 

Once the connections have been finalized, you should use the 
following power-up sequence: 

• Turn on the EPS first. From the System page, choose an SCSI 
ID that is unique within your SCSI network. The Macintosh is 
ID 7 and the standard Macintosh SE internal hard disk is ID 0. 
The EPS defaults to ID 3. 

• Turn on any other SCSI peripherals. 

• Turn on the Macintosh. 
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When powering down the system, simply reverse the above order. 

When you start your Sound Designer II session, don't forget to choose 
Ensoniq EPS (SCSI) within the Sampler menu. Also, within the Sam­
pler .dialog, make sure the SCSI ID number matches the EPS SCSI ID. 

If the EPS ever displays an error condition, it is recommended that you 
power down the system and reboot all SCSI devices. 

Roland S-10, S-220, and MKS-100 
The Roland 5-10, 5-220 and MKS-100 are very similar. In fact, the MIDI 
messages used to transfer samples to and from these samplers are 
identical. In the remainder of this description, "S-10" will refer to both 
the 5-10, 5-220 and MKS-100 samplers. 

The 5-10 is a 12-bit sampler with 4 sample locations. Each sample 
location can hold 32768 samples of data. Sample locations can also be 
combined to support longer sounds. 

The 5-10 uses two sample rates -15 kHz and 30 kHz. 30 kHz is the 
most commonly used. 

The 5-10 does not provide sound names and lengths separately via 
MIDI. Hence the sample structure (e.g. 'A', 'CD' etc.) is used as the 
default name for sounds in the 5-10, and sample lengths are displayed 
as total available memory as opposed to actual sound length. 

The 5-10 only supports release loops (i.e. loops that continue after a 
key has been released). Therefore, sound file with sustain loops will be 
transferred to the 5-10 with release loops. 

NOTE: The selected sample structure must already contain sound data 
- it must not be "empty'' (unsampled). The 5-10 must also have the 
following conditions met to communicate properly with Sound 
Designer II: 
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MIDI system exclusive = 'ON' 
MIDI Channel set to 'l' 
MIDI Active Sensing= "OFF'' (S-10 only) 

If a transfer is cancelled, the S-10 will remain in "SAMPLE DATA 
XMT" or "SAMPLE DATA RCV" mode. To restore communication 
between the Mac and S-10, you must reset the S-10 by pressing a bank 
switch. 

Roland S-550 and S-330 
The Roland S-550 and S330 are twelve bit samplers with 30 kHz and 15 
kHz sample rates. 

Sound Designer II is not able to allocate memory in the S-550 or S-330. 
As a result, you may find that the destination in the sampler is either 
too small or too large for a Sound Designer II sound you wish to send. 
If the sound is too large you will be given the option to truncate the 
sound. Another option is to create a new sample within the S-550 /S-
330 of a more suitable size. 

To use Sound Designer II with the S-550/5-330 you will need to turn 
the S-550/S-330's MIDI System Exclusive parameter to 'On'. You must 
have S-550/5-330 software version 1.0 or higher. 

Roland S-50 
The S-50 is a 12-bit sampler with 32 sample locations. Each sample is 
referred to as a "tone". The S-50 can store over 400,000 12-bit samples 

The S-50 uses two sample rates-15 kHz and 30 kHz. 30 kHz is the 
most commonly used sample rate. 

The S-50 only supports release loops (i.e. loops that continue after a 
key has been released). Therefore, sound files with sustain loops will 
be transferred to the S-50 with release loops. 
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Sound Designer II can only replace sounds in the S-50. Hence for a 
sound file to transfer untruncated to the S-50 there must be a tone 
(sample) of equal or greater size available in the S-50. You might want 
to create a "template" disk for the S-50 consisting of commonly used 
sound sizes. 

If you preview a sound and later adjust the loop points within the 
waveform display you can send the new loop points to the S-50 by 
holding down the option key while clicking on the preview icon. 

NOfE: The S-50 must meet the following conditions in order to 
communicate properly with Sound Designer II: 

Use system software 2.0 or higher. 
MIDI system exclusive = 'ON' 
Set the device ID to '1' 

Oberheim DPX-1 
The Oberheim DPX-1 is a 12-bit sample player with 100 sound loca­
tions. It can store 512K words of data. The DPX-1 can load disks from 
the E-mu Emulator II, Sequential Prophet 2000, Ensoniq Mirage and 
Akai S900. 

The DPX-1 uses the MMA sample dump standard to transfer sounds. 

NOfE: The DPX-1 needs to have system ROM 1.5 or higher to operate 
properly with Sound Designer II. 

Sample Dump Standard (12 bit and 16-bit) 
The Sample Dump Standard (SOS) was developed and proposed to the 
MIDI Manufacturers Association (MMA) in order to free sampled 
sounds from the confines of any one sampler. SOS facilitates sound 
transfers between samplers made by different manufacturers. Without 
SDS (or a computer program such as Sound Designer II), you would 
have to resample a sound to transfer it from one sampler to another, 
adding noise and distortion in the process. 
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The 16-bit setting should be used only with samplers that support a 
full 16-bit data dump, such as the Akai 51000 and the Simmons SDX. If 
you attempt to send a file to a 12-bit sampler, the Sample Dump 
Standard (12-bit) setting should be used as the receiving device may 
not be able to accept a 16-bit data dump. 

Although the SDS was meant to be a standard, there are a couple "grey 
areas" left undefined. The following two "grey areas" should help 
explain some of the quirks of working with an SDS sampler. 

First, there is no way of knowing (via MIDI) whether a sound is 'not 
sampled' or 'non-existent'. A 'not sampled' sound is a sound location 
that is available but as yet not sampled. A 'non-existent' sound is one 
that cannot be created on the sampler (e.g. "sound 33" in a sampler 
that only holds 32 sounds). 

Second, there is no way to determine from the Macintosh whether or 
not a sampler will accept a sound. Some samplers will allow you to 
replace a sound, but not transfer to an unoccupied location. Other 
samplers allow both the replacement of a sound as well as the alloca­
tion of a new sound location. If Sound Designer II attempts to transfer 
to a less cooperative sampler, a "transfer unsuccessful" message will 
appear. 

In general, sound transfers with an MMA SDS sampler will go 
smoothly if you are aware of the limitations of your sampler. You 
should know how many sample locations are available in your sam­
pler, and whether your sampler will accept transfers to unoccupied 
sample locations. 

Karg DSS-1 
The Korg DSS-1 is a twelve bit sampler with a maximum sampling 
time ranging from 5.5 seconds to 16 seconds, depending on the sample 
rate used. The DSS-1 has four sample rates available: 15625 Hz, 23810 
Hz, 31250 Hz and 47620 Hz. 
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If you sample sounds using the 47620 Hz sample rate, you must do 
the following before transferring those sounds to the Macintosh: 

• Enter the Multi Sound mode on the DSS-1. 

• Select Function #3. 

• Exit the Multi Sound mode. 

Korg DSM-1 
The Korg DSM-1 is a twelve bit sampler with a total sampling time 
ranging from 22 seconds to 64 seconds, depending on the sample rate 
used. The DSM-1 has four sample rates available: 15625 Hz, 23810 Hz, 
31250 Hz and 47620 Hz. 

Any MIDI cables connected to the DSM-1 MIDI Thru must be termi­
nated (plugged in to a MIDI input). Non-terminated MIDI cables may 
cause communications problems. 

Yamaha TX-16W 
The Yamaha TX-16W is a 12-bit sampler with 64 sound locations. The 
maximum sampling time for a single sample ranges from 5.2 seconds 
to 16.3 seconds, depending on the sample rate used. The TX-16W can 
accommodate several such samples. The TX-16W has 3 sample rates: 
16,667 Hz, 33,333 Hz, and 50,000 Hz. 

TX-16W transfers are performed using a slightly modified version of 
the 12-bit Sample Dump Standard (SOS) driver. Refer to the SOS driver 
description for more information. 
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Recommended Reading 

Audio in Media, Stanely R. Alten, Wadsworth Publishing Company, 
Belmont, California, 1986 

Principles of Digi.tal Audio, Ken C. Pohlman, Howard W. Sams and 
Company, Indianapolis, Indiana, 1985 

The Ultimate Home Studio, Michael Goldberg, Digidesign, 
Menlo Park, California, 1991 

Random Access Audio, David Miles Huber, Digidesign, Menlo Park, 
California, 1989 

Mix Magazine, 6400 Hollis St. #12, Emeryville, CA 94608 

Electronic Musican Magazine, 6400 Hollis St. #12, Emeryville, CA 94608 

Keyboard Magazine, 20085 Stevens Creek, Cupertino, California, 95014 
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Technical Specifications 

Audio Interface 

Sample Rates: 44.1 kHz, 48 kHz, user selectable 

Analog to Digital Convertor: 1 Bit, Delta-Sigma, 64x Oversampling, 16-bit output. 

Digital to Analog Convertor: 18-Bit, 8x Oversampling 

Frequency Response: 20 Hz - 20 kHz 

Signal to Noise Ratio: > 93 dB A/D, > 108 dB DI A ("A" weighted) 

THD + N: 0.005% AID, 0.003% DI A 

Nominal Input Level: +4 dBu plus 14 dB headroom, adjustable± 6 dB 

Maximum Input Level: +26 dBu 

Nominal Output Level: + 4 dBu plus 14 dBu headroom, adjustable± 6 dB 

Maximum Output Level: +24 dBu 

Analog I/O Types: Balanced, +4 dBu male/female transformerless XLR 

Digital I/O: AESIEBU and SIPDIF, user selectable 

Digital I/0 Types: AES /EBU -XLR connectors 
Input: Active transfonnerless balanced 
Output: Transfonner-coupled 

S/PDIF - RCA connectors 
l~t: Active transfonnerless unbalanced 
Output: Transformer coupled 

Power Requirements: 100, 120, 220, 240 V AC automatic voltage switching 50 - 60 Hz, 16 
w 
Dimensions: lU External Rackmount device, 19"x 1.75" x 10.5", 6.5 lbs (3 kg). 
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Sound Accelerator II 

Card Specifications: Macintosh II NuBus card, installable in any Macintosh II, Ilx, Ilcx, 
Ilci, Ilfx CPU NuBus slot. (Macintosh Ilsi requires Apple NuBus adapter) Each card 
produces four channels of phase synchronous 16-Bit audio 

Digi.tal Signal Processor: Motorola 56001 processor 

Slot Requirements: Slot independent, can be installed in any full-size Macintosh II 
NuBus slot; multiple cards may be used simultaneously 

Connector: Digidesign proprietary 50 conductor to Audio Interface 

NuBus Power Consumption: 6.5 watts 

246 Sound Designer II 



Index 



248 Sound Designer II 



A 

ADC 207 
Add New Channel 193 
Add Samplers 137 
AES/EBU 19 
AIFF 89, 176 
Akai S1000 232 
Akai S700 231 
Akai S900 231 
Akai S950 231 
Akai X7000 231 
Appletalk 136 
Archiving Suggestions 219 
arrows 

in Crossfade Loop dialog 146 
Audio 

as waveforms 56-59 
Audio Input 

digital 18 
Audio Inputs 

analog 18 
Audio Interface 4 

and AC power 15 
and CD Recorders 17 
and DAT players 17 
Back Panel 17 
Calibration of 221 
CH 1,2 Input 21 
digital formats 21 
"Digital H sync mode 20 
features 13 
front panel 19 

Index 

Index 

installing 14 
level meters 21 
level trim 22 
peaklevelof 221 
Power 19 
sample rates of 21 
setting parameters of 14 
sync modes 20 

Audio Output 
digital 18 

Audio Outputs 
analog 18 

Audio Regions 
creating 56-59 

AUTO arrows 
in Crossfade Loop dialog 146 

Auto-name Playlists 
setting in Preferences 201 

Auto-name regions 
setting in Preferences 201 

B 

Back Panel 17 
Bars and Beats 

in Scale Marks command 197 
Black burst 217 
Breakpoint 80 
Butt splice 68 
Bypass 109 

c 
Calibrating the Audio Interface 221, 221-223 
Capture 

249 



in Set Current Time 202 
Capture Region 191 
Capturing SMPTE 162 
Casio FZ-1 234 
Casio FZ-10M 234 
CD Recorder 

and Audio Interface 17 
Change Gain 97 
Change Gain... 184 
channel 

in Crossfade Loop dialog 146 
Channel 1,2 Input 21 
Clear 92, 182 
clip indicators 54 
Clipping 221 
clipping 98 
Close 34, 177 
Close Box 34 
Compressed file format 178 
Compressor/Limiter 117 
contiguous 53 
Continuous Resync 157-171 
Continuous SMPTE Resync 156 
Continuous SMPTE Resynchronization 214 
Continuous SMPTE Sync 197 
Copy 93, 182 
crossfade 

butt splice 68 
duration 71 
equal power 69 
fast-in, slow-out 69 
in Playlists 68 
linear 69 
setting 70 
slow-in, fast-out 69 

Crossfade button 
in loop window 144 

Crossfade Loop 

250 

about 144 
crossfade loop length 145 
Crossfade Looping dialog 

opening 144 
CS-1 223-227 
CS-10 227-231 
Cut 93, 181 

D 

DAC 208 
DAT players 

and Audio Interface 17 
DAT Recorders 220 
DAT Recording Decks 220 
DATa 220 
Data Indicator Boxes 44 
Decimal Sample Number 

in Scale Marks command 196 
Default crossfade 

setting in Preferences 202 
Default Sample Rate 21 
Defining Regions 45 
Delete Playlist... 190 
Delete ... 

files 179 
Destructive editing 31 
Device ID 138 
"Digital 

sync mode 20 
Digital Format 21 
Direct from disk 37, 197 
Disk Buffer 53, 55 
Display Scale Arrows 

in loop window 143 
Display Scale arrows 40 
Dithering 197 
DSP 10 

about 99 

Sound Designer II 



destructive 108 
non-destructive 108 
testing 109 
turing off 1 09 

Dynamics 188 
about 117 
common functions 

attack 118 
detection 118 
input 118 
output 119 
ratio 119 
release 119 
threshold 118 

using 119 

E 

E-mu Emax 235 
E-mu Emax II 235 
E-mu Emulator II 235 
E-mu SP-1200 235 
Edit Regions... 191 
Editing 

non-destructive 31-32 
edits 

previewing 192 
Emulator Ill 235 
Ensoniq EPS/EPS • m 237 
Ensoniq Mirage/Multisampler 237 
Equal Power 

in Crossfade Loops dialog 145 
Erasable Optical Drives 219 
Eraser 80 
Expander 118 

F 

fade 
regions within soundfiles 96 

Index 

Fade In 184 
Fade Out 184 
fader adjustments 

in DSPwindows 109 
Fades 192 

in Playlists 79 
fades 

creating envelopes 80 
removing envelope points 80 

Fast Forward 59 
Feet and Frames 

in Scale Marks command 196 
FFT Analysis 

about 121 
FFT analysis 

generating 124 
invoking 195 
setup 121 

amplitude 122 
bands 122 
direction 122 
frequency range 122 
time interval 123 
type 122 

Find Marker 193 
Forward loops 145 
Forward/Backward loops 145 
Frame Rates 

choosing 153 
problems with 169 

Frame-locked regions 7 4 
Frequency Analysis 188 
Frequency Plot 195 
Frequency Plot... 121 
Front Panel 19 

G 

Get Info... 180 1111 
251 



Graphic EO 188 
about 115 

H 

Hard Disk Requirements 5 
Hard Disk Specs 218 
Hardware Setup 14 
Harware Setup 23 
HDPlay Buffer Size 200 
Headroom 221 
Hex Sample Number 

in Scale Marks command 196 
high-pass filtering 

in Parametric EO 110 
High-shelf filtering 

in Parametric EO 111 
Horizontal Scales 

setting in Preferences 202 
House sync 217 
Hr:Min:Sec:Msec 

in Scale Marks command 196 

i.Audio Interface 
interface cable 15 

i.Sound Accelerator 
interface cable 12, 13 

Info button 
in Crossfade Looping dialog 145 

input level 
setting 54 

Interface port 12, 13, 15, 18 
Invert 99, 183 

K 

Key Commands 45 
Karg DSM-1 243 

252 

L 

Level Meter 21 
Level Trim 22 

calibration of 221 
levels 

optimizing on playback 97 
Linear crossfade loops 145 
Locate 

numbered marker 46 
region end 46 
region start 46 

locating 
numbered markers 41 

Locating Regions 46 
Loop End Marker 43 

placing 141 
loop number 146 
Loop playback 38 
Loop Start Marker 42 

placing 141 
Loop Window 186 

using 142 
Loop window 

opening 142 
Loops 

about 140 
deleting 147 

loops 
creating 141 

low-pass filtering 
in Parametric EO 111 

low-shelf filtering 
in Parametric EO 110 

LTC 162, 210 

M 

Mac-> Sampler 177 

Sound Designer II 



Mac->Sampler 139 
Mac-to-Sampler button 37 
markers 

locating text or loop 193 
memory 

required for crossfades 71 
memory size 

increasing 200 
Merge 104 
Merging soundfiles 103, 187 
MIDI Interface 195 
MIDI interface 4 
MIDI Interface... 134 
Ml DI Keyboard 185 
MIDI Manager 5, 135 

and SMPTE 169 
MIDI Time Code 218 
MIDI TimePiece 218 
Mix 101 
Mixing soundfiles 100, 187 
Monitor 54 
MTC 218 

N 

New Playlist... 189 
New... 51 
No Backup 177 
Noise Gate 118 
Nominal levels 221 
Non-destructive editing 50 
Normalize 97, 184 
Numbered Marker 41 
Numbered Markers 

placing during playback 64 

0 

Oberheim DPX-1 241 
On Line 55 

Index 

On line 160-162 
On-Line 199 
Open Playlist... 190 
Open... 88, 176 
Optical drives 200 
optical drives 54 
overlap transition 69 
Overview Display 34, 56 

p 

Page Setup... 179 
Parametric EQ 187 

about 110 
adjusting 111 
retrieving settings 114 
saving settings 113 

Paste 93, 94, 182 
patch bay 

MIDI 134 
Pattern 

in MIDI Keyboard dialog 186 
peak/notch filtering 

in Parametric EQ 110 
Pencil 38 
Percent Full Scale 

in Scale Marks command 196 
Pitch Shift 128, 189 
Pitch Shift with Time Correction 128 
Play 59 

in MIDI Keyboard dialog 186 
Playback 46 
playback 35, 38 

for any point 59 
from beginning 59 
from current position 59 
from window position 59 

Playback degradation 207 
Playlist 43, 49 

253 



accessing 43 
creating 65, 189 
definition 50-84 
deleting entries 75 
editing 74 
playing 67 
previewing transitions 73 

Playlists 
creating 60 
Deleting 190 
fading 192 
opening 190 
renaming 75, 190 
saving as soundfiles 84, 190 

post-crossfade 70 
post-roll 77 
Power 20 
Power cable 19 
Power input 

outside U.S. 19 
Pre-Allocate 53 
Pre-allocate hard disk buffers 

setting in Preferences 201 
Pre-allocate HD buffers 38, 197 
pre-crossfade 70 
Pre-roll 77 
Preferences 200 
Preview Edit 192 
Preview edit post-roll 

setting in Preferences 202 
Preview edit pre-roll 

setting in Preferences 201 
Preview Edit... 73 
Print... 179 
Pro Store 218, 219 
Process 108 
Pro EDIT 

taking offline 161 

254 

Q 

Quantized Sample Value 
in Scale Marks command 196 

Quit 180 

R 

RAM Buffer 200 
range 

selecting 39 
Record 55 

in MIDI Keyboard dialog 186 
region 

selecting 
with arrow keys 62 

Regions 
creating 56-59 
definition 50-84 

regions 
adjusting end points 78 
adjusting volumes 72 
capturing 191 
copying 75 
duplicating within soundfiles 93 
editing 191 
editing from Playlist 76 
editing from playlist 7 4 
moving within soundfiles 92 
removing from soundfile 92 
renaming 190 
replacing within soundfiles 94 
reversing 95 
selecting 61 

with markers 64 
with Scrubber 63 

silencing 95 
trimming excess data 95 
un-timelocking 191 

Sound Designer II 



Removable Platter Drives 219 
Rename Playlist... 190 
Rename Region... 190 
Replace 94, 183 
Resource 

saving as 178 
Resources 

opening 90, 177 
Return To Zero 55 
Reverse 95, 183 
Revert to Saved 179 
Rewind 46, 59 
Roland MKS-100 239 
Roland S-10 239 
Roland S-220 239 
Roland S-330 240 
Roland S-50 240 
Roland S-550 240 

s 
S/PDIF 18 
Sample Dump Standard 241 
Sample Rate 52 

of Audio Interface 21 
Sample rate 

default 21 
of compact discs 209 

sample rate 
verifying 107 

sample rate conversion 106, 187 
Sampler 203 
Sampler -> Mac 177 
Sampler->Mac 139 
Sampler... 136 
Samplers 231 
samplers 5 
Samples 

defined 207 

Index 

samples 
sending and receiving 138 

Sampling Concepts 207 
Save 82, 178 
Save a Copy... 178 
SaveAs 82 
Save Playlist as Soundfile... 190 
Scale Marks 196 
Scale Marks... 45 
Scale Marks ... command 36 
Screen Cursor 193 
Scroll After Play 199 
Scrubber 40, 44 
Select All 185 
Selector 39 
Set Colors 203 
Set Current Time 154, 202 
Set Interval 203 
Show Clipboard 185 
Silence 96, 183 
Slave Clock In/Out 18 
Smoothing 93, 184 
SMPTE 

explaination 210 
frame rates 153-154 
How to use 216 
in Scale Marks command 196 
troubleshooting 168 

SMPTE format 
choosing 154 

SMPTE Formats 153, 211 
"problem" rates 169 

SMPTE Offset 160 
SMPTE Resync 156, 157-171 
SMPTE Start Time 191 

setting 191 
SMPTE Trigger 156, 156-160, 214 
Sound Accelerator 

255 



don't flexl 11 
in Sound Playback parameters 197 
installing 11 

Sound Accelerator II 4 
Sound Designer file format 89, 176 
Sound Designer II 3 
Sound Designer II file format 89, 176 
Sound Driver 

in Sound Playback parameters 198 
Sound Manager 

in Sound Playback parameters 198 
Sound Playback 197 
Sound Playback... 60 
soundfile 32 
Soundfile Window 33 
Speaker 46 
Speaker button 37 

in Loop window 143 
SR Convert 106, 187 
Stack Windows 194 
Stop 55, 59 
Streaming Tape Drives 219 
Studio 3 218 
Sync Mode 20, 159 
Synchronization 210 

Reasons for 213 
Synchronization Methods 214 
Synchronization Type 156 

T 

Tape Deck 43, 49 
accessing 43, 52 

Technical support 1 O 
Text Marker 42 
Tile Windows 194 
Time 

in Scale Marks command 196 
Time Code 210 

256 

Time Comp/Expand 125, 188 
Time Compression and Expansion 125 
Time Correction 

option in Pitch Shift 189 
time line 56 
Time locked regions 166 
Time Scale 

Time Code 155 
Title Bar 34 
Transfer... 180 
Trash Can 45 
Trigger 156 
Trigger on Nudge 78 
Trim 95, 183 
Troubleshooting SMPTE 168-171 

u 
Un-Timelock Regions 191 
Undo 91, 181 
Use Backup Files 34, 90, 179, 199 
Use Dither 197 
Use for playback 109 

v 
Vertical Scales 

setting in Preferences 202 
Video Slave Driver 158, 215 
View Indicator 35 
VITC 162, 211 
VU levels 221 

w 
Waveform Display 36 
Waveforms 

understanding 56-59 
windows 

displaying and arranging 194 

Sound Designer II 



Wiring diagram 16 
WORM Drives 219 

y 

Yamaha TX-16W 243 

z 
Zoomer 38 

Index 257 



258 Sound Designer II 


